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100 GENERAL
101 Introduction
Computer-Aided Drafting and Design (CADD) is the preferred method of preparing plans for the Ohio
Department of Transportation (ODOT). The requirements presented in this manual ensure that CADD
files can be used by the entire project team (surveyors, planners, environmentalists, designers,
reviewers, contractors, etc.) throughout all phases of project development.
ODOT has adopted MicroStation and GEOPAK as its standard drafting and design software packages,
respectively. The standards referenced in this manual have been developed and tested using the
MicroStation V8i (SELECTseries 4) and GEOPAK V8i (SELECTseries 4) software versions listed on the
following Web page:
http://www.dot.state.oh.us/Divisions/Engineering/CaddMapping/CADD_Services/Support/Pages/Software.aspx

The January 2015 update to ODOT’s CADD Standards included new “ODOTcadd” Standards for use with
MicroStation and GEOPAK (SELECTseries 4), including support for Bentley’s OpenRoads Technology. The
OpenRoads Technology tools are included with the installation of GEOPAK (SELECTseries 4).
The new ODOTcadd standards include many of ODOT’s previous ODOTstd\V8istd CADD Standards for
MicroStation and GEOPAK with additional newly developed standards for Bentley’s OpenRoads
technology; however, there are some changes that are not backwards compatible with previous releases
of ODOT’s CADD Standards and existing projects. ODOT recommends completing existing projects using
the previously published ODOTstd CADD Standards. New projects started after January 2016 with
MicroStation and GEOPAK (SELECTseries 4) should be started using the new ODOTcadd Standards.
Existing projects that are to be completed using the legacy ODOTstd CADD Standards can be completed
using MicroStation and GEOPAK (SELECTseries 4) software versions. It is not necessary to complete these
projects using the MicroStation.GEOPAK (SELECTseries 2) software unless you are specifically using the
Roadway Designer or GEOPAK Site tools which have been removed from the GEOPAK (SELECTseries 4)
software.
New projects created after January 2016 should be started using the ODOTcadd Standards detailed in
this manual. The legacy ODOTstd CADD Standards will no longer be updated.
This manual supersedes all CADD standards previously published in the Bridge Design Manual, the Rightof-Way Manual, and the Location and Design Manual, Volume 3.
This manual is not a textbook and does not exempt the professional from performing responsible
engineering and/or surveying. It is intended to provide uniform procedures and standards for
organizations that perform CADD related services for ODOT. The professional shall have final
responsibility for the accuracy of all input and output of computer-based applications.

101.1 Software
ODOT operates internally using MicroStation and PowerGEOPAK CADD Software only. References made
to GEOPAK software throughout this document shall include the GEOPAK Civil Engineering Suite and/or
PowerGEOPAK.
ODOT will accept electronic and printed deliverables generated from Autodesk tools.
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The design software to be used on a project shall be mutually agreed upon by the District and consultant,
and shall be explicitly stated in the project’s scope. Once the decision has been made to use either
MicroStation/GEOPAK or Autodesk, there shall be no deviation from the agreed upon design package,
and the same one shall be used until the project’s completion.
This document is specific to ODOT’s use of MicroStation and GEOPAK software. ODOT will provide no
support, standards, documentation, or guidance of any kind with respect to design and delivery using
Autodesk tools. All CADD related documentation, training, supporting files, and customization provided
by ODOT shall be MicroStation/GEOPAK based only.
Autodesk provides a Civil3D State Kit for use with Autodesk software. A link is provided on the ODOT
website to download the State Kit at the following Web page:
http://www.dot.state.oh.us/Divisions/Engineering/CaddMapping/CADD_Services/Information/Pages/Autodesk.asp
x

ODOT offers no support for the Autodesk Civil3D State Kit.
The final deliverables of an Autodesk designed project in printed or electronic format shall mimic that
of a project designed and delivered using MicroStation/GEOPAK. The electronic deliverables for projects
designed using Autodesk tools shall be delivered in the native Autodesk format, and not converted to
MicroStation/GEOPAK format.

102 Distribution
This manual, in its entirety, may be freely copied and distributed for the purpose of providing a consistent
guide to the CADD requirements of the Ohio Department of Transportation. The manual, Standard CADD
files and other support files can be downloaded from the ODOT CADD Standards website at the following
address:
http://www.dot.state.oh.us/Divisions/Engineering/CaddMapping/CADD_Services/Pages/default.aspx
For ODOT CADD Users, MicroStation and GEOPAK CADD Standards are located on each District and Central
Office CADD Server under the ODOTcadd\Standards directory. The legacy ODOTstd CADD Standards are
located under the ODOTstd\V8istd folder.

103 Revisions and Updates
The Office of CADD and Mapping Services, CADD Section, with input from ODOT’s District Offices and
the consultant and construction community, will develop, and maintain procedures and standards for the
Department’s CADD related activities. CADD Manual holders are encouraged to submit comments and
suggestions for improvements to the manual or ODOT’s CADD Standards. Any errors found should be
brought to the attention of the ODOT Office of CADD and Mapping Services via the following online
support request:
https://odot.formstack.com/forms/cadd_servicerequest
The Ohio Department of Transportation strives to stay current with state of the art trends in the market.
However, impacts on project delivery schedules and the resources necessary to provide future support for
new features must be considered prior to any change.
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Updating this manual is intended to be a continuous process and revisions will be issued periodically per
the release dates stated on the Design Reference Resource Center (DRRC) web page at the following
address:
http://www.dot.state.oh.us/drrc/Pages/default.aspx
The DRRC web page also provides the option to subscribe to an email list for notification of updates to
ODOT’s Standard CADD Files. Once you have subscribed to the ODOT CADD Standards mailing list, it is
your responsibility to notify ODOT of a change of email address by unsubscribing your old email address
and re-subscribing using your new email address. See the DRRC web page for instructions on subscribing
and unsubscribing.
Revisions to the manual are noted in red text.

104 Trademarks
MicroStation is a registered trademark of Bentley Systems, Incorporated. GEOPAK is a registered
trademark of GEOPAK Corporation, now a wholly owned subsidiary of Bentley Systems, Incorporated. ©
2015 Bentley Systems, Incorporated.
Autodesk is a registered trademark of Autodesk, Incorporated.
Other trade names, computer protocols, and file formats mentioned in this manual are the trademarks of
their respective owners. In no event will the appearance of any graphic, description of any graphic, picture,
screen display, or any other method of conveying meaning be considered to impair the rights of the
respective owners.
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200 CADD STANDARDS
201 Installation and Configuration
201.1 General
This section outlines the setup for a typical installation of MicroStation V8i at ODOT. The configuration
files discussed in this section are available from the ODOT CADD Standards website.
The ODOTcadd Standards can be downloaded from the ODOT website from the following page:
http://www.dot.state.oh.us/Divisions/Engineering/CaddMapping/CADD_Services/Standards/Pages/Files.aspx

201.2 Installation
For a typical ODOT installation, Bentley software is installed in the default location.
This manual provides an overview of the configuration files and variables. Detailed configuration
information can be found in the document \ODOTcadd\Standards\ReadMe-ODOTcadd.pdf.

201.3 CADD Standards Directory
The configuration and associated files for MicroStation and GEOPAK that are used for plan development
at ODOT are typically stored in a directory tree with the root of the tree named “\ODOTcadd” This
directory structure is set to i:\ODOTcadd for a typical ODOT installation, where “i” is a network drive
mapped to the primary CADD file server.
Configuration files and the associated CADD standards are stored in separate folders beneath the
ODOTcadd folder as shown below:

•

Local
The local directory contains site specific CADD Standards for MicroStation and GEOPAK such as
plot configuration files.

•

Standards
The Standards directory contains all the CADD Standards for MicroStation (SELECTseries 4) and
GEOPAK V8i (SELECTseries 4) and greater.

201.4 Configuration Variables and Files
The ODOTcadd configuration represents a significant change in the way ODOT’s configuration variables
are defined.

4

•

ODOT will use a Site Configuration file (ODOT_Site.cfg) to define site specific variables that
are universally defined for all projects.

•

MicroStation Project Configuration Files (.pcf) will be used to define project specific variables
that are unique to each project.
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•

ODOT users will access MicroStation or GEOPAK via desktop shortcuts. Separate shortcuts are
defined to access MicroStation or GEOPAK using either the new ODOTcadd Standards or the legacy
ODOTstd\V8iSTD standards.

The following configuration files are used with the ODOTcadd standards:
•

z_ODOT_redirect_network.cfg or z_ODOT_redirect_local.cfg
The redirect file is used to set various custom configuration variables to access either the
ODOTcadd standards or the legacy ODOTstd\V8iSTD standards. These variables define the paths
where ODOT specific data is located.
z_ODOT_Redirect_local.cfg is used for installations where the ODOTcadd folder will be housed
in the root directory of the local computers C:\ drive.
z_ODOT_Redirect_network.cfg is used for installations where the ODOTcadd folder will be
housed on a network drive.
The redirect file calls \ODOTcadd\Standards\config\Standards\ODOT_Site.cfg
The following variables are defined in the redirect file for the ODOTcadd Standards:
ODOT_ROOT
This variable is defined to specify the root folder location for the \ODOTcadd folder.
ODOT_STD
This variable defines the path to the \ODOTcadd\Standards folder
ODOT_LOCAL
This variable can be used to define the location where site specific CADD Standards are
located such as plot configuration files.
ODOT_USER
This variable defines the path to the user preference files (.upf)
ODOT_PROJECT
This variable defines the path to the MicroStation project configuration files (.pcf)
ODOT_TEMP
This variable defines the path for temporary resources. The following sub-directories
must be created in the location defined by the ODOT_TEMP variable:
\rsc
\scr
\sketchupimage
\tmp
The following variables are defined in the redirect file for the legacy ODOTstd\V8iSTD standards:
ODOTSTD
This variable is defined to specify the root folder location for the \ODOTstd folder.
V8iSTD
This variable defines the path to the \ODOTstd\V8istd folder.
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HOMEV8i
This variable is used to define the location for the MicroStation User Configuration (UCF)
and User Preference (UPF) files.
V8iSTD_PROJDIR
This variable defines the location for MicroStation Project Configuration (PCF) files.
•

ODOT_Site.cfg
This site configuration file is used to define the configuration variables for ODOT’s MicroStation
V8i (SELECTseries 4) CADD standards. This file resides in the following folder:
\ODOTcadd\Standards\config\Standards

•

dfltuser.cfg
This file tells MicroStation what UCF file to use on initial startup. The default is ODOTcadd.ucf.

•

ODOTcadd.ucf
This UCF file is the default user configuration file for use with ODOTcadd. This file can be used
to define any user specific configuration variables for MicroStation or GEOPAK.

201.5 Desktop Shortcuts
ODOT will use separate desktop shortcuts to open MicroStation or GEOPAK with the appropriate ODOT
CADD Standards depending on the project being accessed. Each desktop shortcut uses a workspace switch
to access either the legacy ODOTstd\V8iSTD CADD Standards (-wsODOTv8istd) or the ODOTcadd
Standards (-wsODOTcadd).
See the document \ODOTcadd\Standards\ReadMe-ODOTcadd.pdf for more information.
For additional information on installation and configuration of the ODOTcadd standards, please visit the
ODOT CADD Services YouTube channel.

202 Level Assignments
202.1 General
To maintain uniformity among different drawing files, it is essential that an organized leveling system
be used. MicroStation permits data to be organized in any fashion on an unlimited number of drawing
levels. ODOT has developed a standard set of levels to be used with all design files submitted to or
exchanged with the Department.
ODOT’s standard levels are defined in a MicroStation DGN Library, ODOT_Levels_General.dgnlib, which
can be obtained from the ODOT CADD Standards website. The DGN library is attached by use of the
MicroStation configuration variable MS_DGNLIBLIST.
Users shall not create their own levels for use in any design files submitted or exchanged with ODOT.
See the CADD Information Table, Appendix A, for a complete list of the ODOT levels.
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202.2 Level Naming Convention
ODOT level names use the following naming convention:
Classification_Disposition_Logical Name
The Classification consists of two (2) uppercase characters used to group the levels into categories. The
Classification names are listed in the table below:
Classification

Description

Classification

AP
BD
BR
CM
DR
DT
DV
EV
GE

Airports
Buildings
Bridge
Corridor Modeler
Drainage
Digital Terrain Models
Divisions
Environmental
Geometry

PV
RC
RD
RS
RW
SC
SG
SH
SN

GK

GEOPAK

ST

GM
GT
HY
LT
MD
MT
PF
PM

Geomedia (County Maps)
Geotechnical
Hydraulics
Lighting
Modeling
Maintenance of Traffic
Profiles
Pavement Marking

SV
TR
TX
UT
MD
VG
XS

Description
Pavement
Recreational
Roadway
Raster Files
Right-of-Way
Scratch
Signals
Sheets
Signs
Standard Construction Drawings &
Plan Insert Sheets
Survey
Truck Turning Paths
Text
Utilities
3D Modeling
Vegetation
Cross Sections

The Disposition is used to identify the level for placement of either X (existing) or P (proposed)
information.
The Logical Name is used as a description of the element contents. Where appropriate, common industry
abbreviations are used.
All ODOT levels names use alphanumeric characters only. No spaces or special characters are used other
than the underscore “_” character.

202.3 ByLevel Considerations
In general, to facilitate use of MicroStation’s ByLevel attributes, the ODOT levels have been established
such that each curvilinear feature will have its own level. In order to keep the overall number of levels
manageable, there are cases where similar features will be placed on the same level making it impossible
to use ByLevel attributes for those features. Some exceptions are noted below:
•

Standard ODOT cells are placed on the level in which they were created. Each cell is not placed
on its own level, rather, like cells are grouped on one level. For example, existing electric utility
cells are all placed on the level UT_X_Electric_Cells.

•

Storm Sewer Lines – Each proposed storm sewer line 12” and above will be placed using the
custom line style stormline, which shall be scaled, based on the pipe size. All proposed storm
sewer lines will be placed on the level DR_P_Storm_Sewer.
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•

Culvert Lines – Each proposed culvert line will be placed using a custom line style based on the
culvert size. All proposed culvert lines will be placed on the level DR_P_Culvert.

•

Maintenance of Traffic Drums – Multiple line styles have been created to represent various typical
drum spacing’s. These lines are placed on level MT_P_Drums.

•

Centerline Pavement Marking – Multiple line styles and colors are available representing various
centerline pavement markings. These lines are placed on level PM_P_CL (proposed) or PM_X_CL
(existing).

As a general rule, curvilinear design file elements should be placed using ByLevel attributes except in
the cases noted in the CADD Information Table, Appendix A.

202.4 Filters
ODOT’s level library, ODOT_Levels_General.dgnlib, has been configured with a set of default level
filters that can be used to control the display of levels based on their attributes. Users may add new
filters as deemed necessary to facilitate project development. Users shall not edit or delete the default
filters.
The filters included in ODOT_Levels_General.dgnlib are listed in the table below:
Filter

Aerial Mapping

Spatial Features

Topo Features

8

Value

Result

BD_X_Building|"BR_X_SV_Abut"|"BR_X_SV_D
eck_Top"|DR_X_Culvert|DR_X_Headwall|DT
_X_Break_Line|DT_X_TIN_Hull|DT_X_Void|
HY_X_Water_Edge|HY_X_Wetland_Area|PV
_X_Bikeway|PV_X_Curb|PV_X_Driveway|PV
_X_EOP|PV_X_Field_Drive|"PV_X_Shoulder"
|PV_X_Walk|RD_X_Concrete_Barrier|RD_X_
Fence|RD_X_Gate|RD_X_GR_Lt|RD_X_GR_R
t|RD_X_Misc_Items|RD_X_Noise_Wall|RD_X
_RR_2|RD_X_Wall|VG_X_Tree_line_Lt|VG_X
_Tree_Line_Rt
BD_X_Building|DT_X_Break_Line|DT_X_TIN_
Hull|DT_X_Void|HY_X_Water_Edge|PV_X_C
urb|PV_X_Driveway|PV_X_EOP|PV_X_Shoul
der|RD_X_RR_2
BR_X_SV_Abut|BR_X_SV_Deck_Top|DR_X_C
ulvert|DR_X_Headwall|HY_X_Wetland_Area
|PV_X_Bikeway|PV_X_Field_Drive|PV_X_Wa
lk|RD_X_Concrete_Barrier|RD_X_Fence|RD
_X_Gate|RD_X_GR_Lt|RD_X_GR_Rt|RD_X_M
isc_Items|RD_X_Noise_Wall|RD_X_Wall|VG_
X_Tree_Line_Lt|VG_X_Tree_Line_Rt

Airport

AP*

Bridge

BR*

Bridge Beam

Beam – SV|BR_*_Gen_Text

Bridge Bearing

Brg - SV|BR_*_Gen_Text

Displays all levels that are used by Aerial
digital mapping.

Displays levels containing the Spatial
features used by Aerial digital mapping.

Displays levels containing the Topo Features
used by Aerial digital mapping.

Displays levels starting with the characters
“AP”.
Displays levels starting with the characters
“BR”.
Displays bridge levels containing “Beam”
except for levels containing “SV” and
contains the levels for the Bridge Generic
Text.
Displays bridge levels containing “Brg”
except for levels containing “SV” and
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Filter

Value

Bridge Details

Det – [Beam|Brg|Dia|Rail|
Prestress|Slab] |BR_*_Gen_Text

Bridge Diaphragm

Dia - SV|BR_*_Gen_Text

Bridge Drainage

Drain|BR_*_Gen_Text

Bridge General

Gen - SV

Bridge Prestress

Prestress|BR_*_Gen_Text

Bridge Railing

Rail - SV|BR_*_Gen_Text

Bridge Slab

Slab - [Gen|SV]|
BR_*_Gen_Text

Bridge
Sub_Deep_Foundation

Deep - SV|BR_*_Gen_Text

Bridge Sub_Footing

Foot - SV|BR_*_Gen_Text

Bridge Substructure

Sub - [Foot|Deep|SV]|
BR_*_Gen_Text

Bridge Survey

_X_SV

Buildings

BD*

Corridor Modeler

CM*

Cross Sections

XS*

Divisions

DV*

Drainage

DR*

DTM

DT*

Environmental

EV*

Existing Levels

_X_|GT_Historic

Geometry

GE*

GEOPAK

GK*

ODOT CADD Engineering Standards Manual (ODOTcadd)
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contains the levels for the Bridge Generic
Text.
Displays bridge levels containing “Det”
except for levels containing “Beam”, “Brg”,
“Dia”, “Rail”, “Prestress” or “Slab” and
contains the levels for the Bridge Generic
Text.
Displays bridge levels containing “Dia”
except for levels containing “SV” and
contains the levels for the Bridge Generic
Text.
Displays bridge levels containing “Drain”
and contains the levels for the Bridge
Generic Text.
Displays bridge levels containing “Gen”
except for levels containing “SV”.
Displays
bridge
levels
containing
“Prestress” and contains the levels for the
Bridge Generic Text.
Displays bridge levels containing “Rail”
except for levels containing “SV” and
contains the levels for the Bridge Generic
Text.
Displays bridge levels containing “Slab”
except for levels containing “Gen” or “SV”
and contains the levels for the Bridge
Generic Text.
Displays bridge levels containing “Deep”
except for levels containing “SV”
Displays bridge levels containing “Foot”
except for levels containing “SV” and
contains the levels for the Bridge Generic
Text.
Displays bridge levels containing “Sub”
except for levels containing “Foot” or
“Deep” or “SV” and contains the levels for
the Bridge Generic Text.
Displays bridge levels containing “_X_SV”.
Displays levels starting with the characters
“BD”.
Displays levels starting with the characters
“CM”.
Displays levels starting with the characters
“XS”.
Displays levels starting with the characters
“DV”.
Displays levels starting with the characters
“DR”.
Displays levels starting with the characters
“DT”.
Displays levels starting with the characters
“EV”.
Displays all existing levels containing “X”
and “GT_Historic”.
Displays levels starting with the characters
“GE”.
Displays levels starting with the characters
“GK”.
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Filter

Value

Geotechnical

GT*

Hydraulics

HY*

Lighting

LT*

Modeling

MD*

MOT

MT*

Pavement

PV*

Pavement Marking

PM*

Profile

PF*

Proposed Levels

_P_|GT_Instrumented|GT_Project

Raster

RS*

Recreational

RC*

Right-of-Way

RW*

Roadway

RD*

Scratch

SC*

Sheets

SH*

Signals

SG*

Signing

SN*

Std_Constr_Plan_Insert
_Shts

ST*

Survey

SV*

Text (Generic)

TX*|*Text

Truck Paths

TR*

Used

*

Utilities

UT*

Vegetation

VG*
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Result
Displays levels starting with the characters
“GT”.
Displays levels starting with the characters
“HY”.
Displays levels starting with the characters
“LT”.
Displays levels starting with the characters
“MD”.
Displays levels starting with the characters
“MT”.
Displays levels starting with the characters
“RV”.
Displays levels starting with the characters
“PM”.
Displays levels starting with the characters
“PF”.
Displays all proposed levels containing “P”,
“GT_Instrumented” and “GT_Project”.
Displays levels starting with the characters
“RS”.
Displays levels starting with the characters
“RC”.
Displays levels starting with the characters
“RW”.
Displays levels starting with the characters
“RD”.
Displays levels starting with the characters
“SC”.
Displays levels starting with the characters
“SH”.
Displays levels starting with the characters
“SG”.
Displays levels starting with the characters
“SN”.
Displays levels starting with the characters
“ST”.
Displays levels starting with the characters
“SV”.
Displays levels starting with the characters
“TX” and the levels containing “Text”.
Displays levels starting with the characters
“TR”.
Displays levels that are currently in use.
Displays levels starting with the characters
“UT”.
Displays levels starting with the characters
“VG”.
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202.5 Priority and Transparency
The levels defined in the MicroStation DGN Library, ODOT_Levels_General.dgnlib, utilize the Element
Priority and Transparency features. The Priority and some Transparency settings have been incorporated
in ODOT CADD Standards to facilitate the on-screen viewing of the plan features. See the CADD
Information Table, Appendix A, for a complete list of Priority and Transparency values.
•

Priority
Elements, levels, and references can be assigned a Priority value. Elements with a higher priority
will display on top of elements with a lower value.

•

Transparency
Dialog boxes, as well as elements, levels, and references can be set with a transparency value.
Transparent elements allow you to see other graphic elements that are “underneath” a
transparent element.

202.5.1 Priority
Display priority is a technique for specifying the relative front-to-back order in which 2D elements
appear in a 2D model (only) when they are displayed in a view. Display priority is only useful or
necessary for 2D models, since all elements in 3D models have their own explicit 3D coordinate space.
In 3D models, elements closer to the eye are always drawn in front of elements further from the eye
so display priority is not necessary.
The elements with the highest priority values are displayed in front, while the elements with the
lowest priority values are displayed in the back. Values for Element and Level priority may range
from -500 to 500.

By default, MicroStation displays the elements on your screen in the order in which they were drawn.
If you're using reference files, the active file will display first followed by the reference files in the
order of attachment. And finally, if you're using raster reference files, the order is: the raster images
first, then the active file elements, followed by the vector reference files.
Note: Levels for Raster Reference files have been created. The Raster Reference files have
been assigned a low priority value so they will always be displayed behind any existing and
proposed features and references.
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Display priority is not supported in editions prior to MicroStation XM. Files created using display
priority will appear “unsorted” when displayed in previous editions of MicroStation V8, or when saved
to DGN V7.
In 2D models, you can assign display priority values to references, levels, and to individual elements.
The hierarchy for display priority is reference: level: element. That is:
•

All elements in a reference with a higher reference display priority will appear in front of all
elements from references with a lower value.

•

Within a single model, or from references with the same reference display priority, elements
on levels with higher level display priority will appear in front of those with a lower value.

•

Where elements have the same reference and level display priority, the element display
priority determines those that will appear in front of others.

•

Where two elements have the same reference, level, and element display priorities, the one
that appears later in the display order (that is, file position and update sequence) appears
on top.

Levels are the main priority differentiator on top of which the individual elements of a particular
level can be tweaked relative to each other. Priority values have been assigned for each level in the
ODOT level library as shown below.

•
•
•
•
•
•
•

12

Levels for Existing plan features have been assigned a priority value of -100.
Levels for Proposed plan features have been assigned a priority value of 100.
Levels for Existing and Proposed Text have been assigned a priority value of 500.
The level SH_Major_Grid_Line has been assigned a priority value of -480.
The level SH_Minor_Grid_Line has been assigned a priority value of -490.
Levels used for GEOPAK specific features have been assigned various priority values to
facilitate better on-screen viewing of the graphics.
Levels configured for Raster Reference files have been assigned a priority value of -500.
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With these priority assignments, proposed plan view features will always display on top of existing
plan view features regardless of the order in which the elements are drawn.
You do not need to assign a priority value to the elements as they are placed in the design file. The
elements will be displayed according to the priority value that is assigned to the level.
Note: The Active Element Priority value is not a ByLevel setting. When the Active Level is
changed on the Attributes tool bar, the value of the Active Element Priority is not set to match
the value assigned to the level.
In the case where two elements are placed on different levels that have the same priority setting,
the last element drawn is displayed on top. This can be changed by assigning a priority value to the
element. Priority values can be assigned when the element is initially placed, or assigned later with
the Change Element Attributes tool.
The priority value assigned to an element is not an “override” of the level setting. The priority value
assigned to an individual element is “relative” to the level setting. Behind the scenes, MicroStation
uses an equation (See BE Communities for further details) to determine the “final” priority value of
the element. However, most users will be content to know that modifying the priority assigned to
an individual element up or down by increments of one (1) will allow them to modify the display
priority as needed.
It should be noted that the priority value of an element that is reported in the Element Info dialog
is the actual value assigned to the element, not the calculated value.

The priority of an element can be modified using the Change Element Attributes tool.
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Priority can also be assigned to Reference files. By default, where a reference is attached it is
assigned a value of 0 as shown below.

Values for priority assigned to a reference file can range from -5 to 5.
The hierarchy for display priority is reference: level: element. Therefore, when an element is drawn
over referenced graphics, the reference file will take priority over elements placed in the master
design file on a level that has the same priority value.
All of the graphics representing existing features, which are in a reference file, are displayed on top
of the shape drawn on the existing building level, as shown below:

14
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202.5.2 Transparency
Transparency can be set for elements, levels, and references. Transparency may vary from 0% to
100%. A value of 0 indicates no transparency at all, while a value of 100% indicates almost complete
transparency.

Transparency can be assigned to elements when they are placed by selecting a value from the
Attributes tool bar.

Note: The Active Element Transparency value is not a ByLevel setting. When the Active Level
is changed on the Attributes tool bar, the value of the Active Element Transparency is not set to
match the value assigned to the level.

ODOT CADD Engineering Standards Manual (ODOTcadd)

15

July 20, 2018
The Change Element Attributes dialog can be used to set the Transparency values for previously
placed elements.

Just like Priority, when new elements are drawn they take on the Transparency value assigned to
the level. Setting the Active Element Transparency in the Attributes tool box is not an “override”.
Behind the scenes, MicroStation uses an equation (See BE Communities for further details) to
determine the “final” transparency value of the element.
The Transparency value reported in the Element Information dialog box represents the value assigned
to the element and not the “final” transparency value as calculated by MicroStation.

16
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Note: When opening an existing MicroStation V8 design file in XM or V8i, the priority and
transparency values will not be in effect unless an “Update Levels from Library” command is
issued.

203 Colors
203.1 General
Standard colors are specified to ensure consistency and to enable users to easily identify plan elements
in shared files.
Each element in a MicroStation design file is assigned a color number. MicroStation reads a color table
to determine the correct color to display for the specified number. Standard color numbers for plan
graphics are specified in the CADD Information Table, Appendix A.
The ODOT standard color table, ODOT_color.ctb, can be obtained from the ODOT CADD Standards
website. The MicroStation configuration variable MS_DEFCTBL is used to specify the ODOT color table.
The color values may vary or appear different on screen due to the graphics cards, monitors display
capability, etc.
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204 Line Styles
204.1 General
Line styles are used to differentiate curvilinear elements in the design file and on the plotted sheet.
There are eight default line styles available in MicroStation using the values zero (0) through seven (7).
Additionally, ODOT has developed a set of Custom Line Styles to be used for drawing various plan view
graphic items requiring custom symbology. Custom Line Styles are created as Cosmetic or Physical line
types. For detailed information see Section 204.2 - Types of Line Styles.
The ODOT standard line-style resource file, ODOT_Linestyles.rsc, can be obtained from the ODOT CADD
Standards website. The MicroStation configuration variable MS_SYMBRSRC is used to specify the custom
line style resource file.
Users shall not create their own custom line styles for use on ODOT plan sheets.
Standard line codes and custom line styles for plan graphics are specified in the CADD Information Table,
Appendix A and displayed in Appendix D.

204.2 Types of Line Styles
ODOT CADD Standards contain two (2) types of custom line style definitions:
1. “Cosmetic” line styles
Cosmetic line styles are used to represent the location of an item, but not the actual size or
spacing of the item. A fence line, shown below, is an example of a cosmetic custom line style.

•

The location of the symbols along the custom line style does not represent the actual
location of fence posts, and are intended only to designate the line as a fence line.

•

Cosmetic line styles are typically placed in the design file at a scale of one (1) and then
displayed using the Global Line Style Scale or Annotation Scale factors in the design file at
a scale corresponding to the intended plotting scale of the final plans.

2. “Physical” line styles
Physical line styles are used to represent the location of an item, and the linear spacing of the
components of the item. A pavement marking lane line, shown below, which consists of
alternating 10’ dashes and 30’ gaps, is an example of a physical custom line style.

•

Physical line styles are always placed in the design file at a scale of 1, regardless of the
plotting scale.

•

Physical line styles are designated as such that the Global Line Style Scale and Annotation
Scale factors when applied are ignored.

Cosmetic and Physical line styles for plan graphics are specified in the CADD Information Table,
Appendix A and displayed in Appendix D.
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204.3 Line Style Scales
During the development of a set of plans, it is common to reference the same basemap design file into
different detail sheet files that may be plotted at different scales. The location and dimensions of all
plan view basemap design file information shall be drawn in the default “Design” model using real world
dimensions at a 1:1 scale. Custom Line Styles are to be placed in the basemap at a scale of one (1) so
the Model Properties “Line Style Scale” feature can be used.
The Model Properties Line Style Scale feature can be used to control the display size of line styles in
the active design file, and in any Reference attachments. This will allow the designer to control the
display size of the line styles for any intended plotting scale.
All custom Line Styles should be placed at a scale of one (1) and then scaled using the Model Properties
Line Style Scale feature.

The following details the recommendations for Scaling Custom Line Styles when drafting and designing
ODOT plans using the features available in MicroStation V8i. The final decision regarding plan drafting
and design is at the discretion of the designer.
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Recommendations for Scaling Custom Line Styles on ODOT plans:
When attaching the basemaps as References into the “Sheet” model, set the Model Properties Line
Style Scale for the appropriate sheet scale. Changing the Model Properties Line Style Scale value will
cause the display of the line styles to change according to the value selected. This will affect line styles
drawn in the active file, as well as referenced graphics, depending on the settings when the references
were attached.
204.3.1 Basemap:
Manual Placement (Existing and Proposed):
Place all Line Styles in the basemap design file at a scale of one (1.0).

When working in the basemap, use the following steps to set the Line Style Scale:

20
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In the Model Properties dialog box, set the Line Style Scale using one of the following two (2)
methods:
1. From the Line Style Scale drop-down menu, select Annotation Scale to set the line style
scale factor to match the Model Annotation Scale.
Note: This is the recommended procedure for all Roadway Design files.

2. From the Line Style Scale drop-down menu, select Global Line Style Scale to set the line
style scale factor to a value different than the Model Annotation Scale.
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GEOPAK Placement (Existing and Proposed):
The GEOPAK Design and Computation Manager dialog box can be used to place line styles in the
basemap using the default Design mode.

The Design mode is used to plot COGO elements into MicroStation, with the desired symbology, by
use of the Draw Plan and Profile dialog box. It can also be used to set drafting standards used in
conjunction with MicroStation’s element placement commands, with the Place Influence option
toggled on, as shown below:

When using the Design mode the following procedure is used to place Line Styles in the basemap:
Before you begin placing MicroStation elements in Design Mode, it is good practice to check the
Design Settings to ensure that the Custom Line Style Creation’s Scale Factor value is set properly.

From the Design and Computation Manager dialog
box, select Settings > Design to access the Design
Settings dialog box shown at right.

22
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The following options related to Line Style placement are available from or when using the Design
Settings dialog box:

Custom Line Style Creation
The default custom line style Scale Factor to be
used when drawing MicroStation elements is
specified here. For ODOT plans, this value should
be set to one (1.0) as shown right, to allow the
Model Annotation Scale to control the custom line
style scale.

The Annotation Scale is set as follows for Custom Line Styles:
•

Select the Models dialog box.

•

From the Models dialog box, select Edit Model Properties to access the Model Properties
dialog box as shown below.

•

From the Line Style Scale drop-down menu, set the Line Style Scale as desired.

In the example shown right, the
Annotation Scale is set to a value
of Engr 1:20. The Line Style Scale
value is set to match the
Annotation Scale.

204.3.2 Survey Processing (Existing Basemap) using the legacy GEOPAK Survey tools
The GEOPAK Project Preferences dialog box is used to control how the line styles in the basemap
will be drawn when the survey data is processed using the legacy GEOPAK Survey tools. To use the
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Model Properties “Line Style Scale” feature, the field data must be visualized at a scale of one
(1.0) as shown below:

The Plot Scale feature is used to control the size of the custom line styles used in the mapping of
the survey data. The base scale is defined for each feature code in the SMD file. The Plot Scale
should normally be set to a value of one (1.0) for all ODOT projects.
Note: For more detailed information on processing the survey data into MicroStation see the
ODOT GEOPAK V8i Survey Training Guide and the ODOT GEOPAK V8i Road 1 training guide.
204.3.3 Survey Processing using OpenRoads Technology
Survey data processed using the OpenRoads Survey technology is drawn according to the current
MicroStation Annotation Scale setting and will respond to changes in the Annotation Scale value.
For more detailed information processing survey data using OpenRoads technology see the ODOT
GEOPAK Survey with OpenRoads Technology training guide.
204.3.4 Sheet Files
In the “Sheet” model, set the Model Properties Line Style Scale for the appropriate sheet scale.
In the Model Properties dialog box, set the Line Style Scale using one of the following two (2)
methods:
1. From the Line Style Scale drop-down menu, select Annotation Scale to set the line style
scale factor of the lines styles to match the Model Annotation Scale.
Note: This is the recommended procedure for all Roadway Design files.
2. From the Line Style Scale drop-down menu, select Global Line Style Scale to set the line
style scale factor to a value different than the Model Annotation Scale.
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When attaching References in the “Sheet”
model, set the Global LineStyle Scale to Master
in the Reference Attachment Settings dialog
box. This will allow the master file to control
the scaling of line styles in the active file and all
reference attachments.
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Important Notes when Referencing:
•

Be aware that if the Line Styles were placed in the basemap using a Scale factor other
than a Scale of 1. The referenced line styles are scaled by the Model Properties Line
Style Scale set in the new design file and will appear out of scale.

•

For legacy projects, if the survey data was mapped (visualized) in the basemap for a
specific scale, such as 20, set the option “Global Line Style Scale” to Reference in the
Reference Attachment Settings dialog box to match the Annotation Scale value set in
the original reference file.

•

If the Model Annotation Scale is already set in the design file and the Model Annotation
Scale is set in the Reference at 1:1, the Detail Scale in the Reference Attachment
Settings dialog box displays the Model Annotation Scale and the Scale (Master:Ref)
displays a 1:1 scale like shown below:

•

Be aware if the Model Annotation Scale is already set in the design file and the Model
Annotation Scale is set in the Reference other than 1:1, the Detail Scale in the
Reference Attachment Settings dialog box displays the Reference’s Model Annotation
Scale and the Scale (Master:Ref) is then calculated from the referenced model's
annotation scale and the active model's annotation scale.
For example if the Reference file has a Model Annotation Scale set at 1:20 and the design
file has a Model Annotation Scale set at 1:50 the Detail Scale displays the Reference’s
Model Annotation Scale (1:20) and the Scale (Master:Ref) is calculated 2.5:1 as shown
below:

To avoid the Reference from scaling in the design file like shown in the example above
make sure the Scale (Master:Ref) is set to 1:1. If the Scale (Master:Ref) is not set at 1:1
you will need to change it. Once you have set the Scale to 1:1 the Detail Scale will then
read the design file’s Model Annotation Scale that was set like shown below:
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Bridge Design Files:
Multiple custom line styles for centerlines have been designated for specific plotting scales (10 scale, 20
scale, 50 scale, etc). Separate levels have been established for the representation of these centerlines.
These line styles and levels are specified in the CADD Information Table, Appendix A.
Several line styles have been developed specifically for use on Bridge plans that are not always placed
at a specific scale relative to the plotting scale. See Appendix F for suggested Scale factors. The line
styles listed in the table below shall be scaled as necessary to produce a legible detail. These line styles
are assigned to the appropriate level by use of ByLevel attributes.
Line Style Name

Description

brcllong
brclshort
brconstjoint
brexisting

Centerline Long
Centerline Short
Construction Joint
Existing Objects

brhiddenex
brhiddenpr
brphasepr

Hidden Line Existing
Hidden Line Proposed
Phase Construction Line

brbarex
brbarpr

Existing Reinforcement Bars
Proposed Reinforcement Bars

204.4 Plotting
The dash and gap lengths of the MicroStation default line codes 0-7 are defined by the plotting software.
See Section 400 - Plotting for the ODOT plotting values for line codes 0-7.

205 Line Weights
205.1 General
Line weights are used to differentiate graphical elements in the design file and on the plotted sheet.
Line Weight width ranges from weight 0 (narrowest) to weight 31 (widest) and designate the thickness
of the line used to draw or plot a graphic element.
Standard line weights for plan graphics are specified in the CADD Information Table, Appendix A.

205.2 Plotting
See Section 400 - Plotting for information on line weight plotting thickness values.
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206 Cell Libraries
206.1 General
A cell is a complex element composed of a group of primary elements or other complex elements. Cells
are stored in a cell library. For plan consistency, it is advantageous to create cells for items that will be
repeatedly placed in a design file. Several ODOT standard cell libraries are available as detailed in
Section 206.3 - Cell Libraries.

206.2 Cell Types
Most of the cells created in ODOT’s cell libraries have been created as graphic cells. The symbology
(color, line style, line weight, and level) of a graphic cell is determined when it is created. When graphic
cells are placed, they are level-independent, i.e., they do not rotate with the view and they keep the
settings that were active when they were created. A few cells have been created as point cells where
appropriate. A point cell takes on the active symbology set in the file at the time it is placed and are
view independent, i.e., they rotate with the view.
Several “Pattern and Terminator Type" symbols that were created as graphic type cells in the following
cell libraries are now taking advantage of a new feature in MicroStation when placing them in the design
file:
ODOT_Geotech.cel
ODOT_Geotech_1996.cel
ODOT_Symbols.cel
Graphic Cells can be produced on the “Default” Level using specific symbology, such as, color, line style,
and line weight. A benefit to graphic cells being created on the “Default” level is the new symbols act
similar to point cells when placed in the design file they inherit the Active Level, but not the symbology
(color, line style, line weight). It is important to note, that the graphic cell does not inherit the Active
Symbology (i.e. color, weight, line style) like a “Point Cell”, unless the graphic cell was drawn on the
“Default” level with the attributes set to “ByLevel”.

206.3 Cell Libraries
The following Cell Libraries are available to facilitate the drawing of commonly used symbols and sheet
borders as described below:
Cell Library

Description

ODOT_Bridge.cel
ODOT_Drainage.cel
ODOT_Geotech.cel

Commonly used cells for Bridge plans.
Cells for standard drainage structures.
Cells used for Geotechnical Information.

ODOT_Geotech_1996.cel
ODOT_RW.cel
ODOT_Sheets.cel
ODOT_Symbols.cel

Cells used for the Specifications for Subsurface Investigation.
Commonly used cells for Right-of-Way plans.
Cells for standard plan sheet borders.
Cells representing standard plan symbols.

A set of cell libraries has been developed to include standard signs from the Office of Roadway
Engineering, Sign Designs and Markings Manual. These sign cells are easily placed using a custom
application, ODOT_Signs.mvba. A complete list of the sign cell libraries and instructions for running the
signs application can be found on the ODOT CADD Services website.
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The Cell libraries can be accessed from the ODOT CADD Standards website via the MicroStation Downloads
web page.

206.4 Cell Placement
The ODOT cell libraries have been updated to utilize the new enhancement for Annotation Cells. Every
cell can be placed as an Annotation Cell when the new feature “Can be placed as an annotation cell”
is toggled on in the Model Properties dialog box.

When you change the active model's
Annotation Scale value, annotation cells
in the model are automatically scaled by
the new value.
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Annotation Scale - sets the scale for Text, Dimensions and Cells in the model. You can select from the
list of common scales used for ODOT plan sheets. When placing Text, Dimensions or Cells, the Annotation
Lock must be on to ensure that the text, dimensions and cells are placed at the defined scale.
ODOT CADD Standards contain two (2) types of cell definitions:
1. “Cosmetic” cells
Cosmetic cells are used to represent the location of an object and are intended only to designate
the location not the actual size or dimensions of the object. A Mail Box, shown below, is an
example of a cosmetic cell.

•

Cosmetic cells are typically placed in the design file at a scale of one (1) and then displayed
using the Annotation Scale factors in the design file at a scale corresponding to the intended
plotting scale of the final plans.

•

The ability to place Cosmetic cells using the Annotation Scale Lock has been enabled in the
cell definition by toggling on the Can be placed as annotation cell option.

2. “Physical” cells
Physical cells are used to represent the actual size or dimensions of an object. A Catch Basin,
shown below, is an example of a physical cell.

•

Physical cells are always placed in the design file at a scale of 1, regardless of the plotting
scale and are designated as such that the Annotation Scale factors when applied are ignored.

•

The ability to place Physical cells using the Annotation Scale Lock has been disabled in the
cell definition.

The Place Active Cell tool is used to place annotation
cells. The tool's settings window has an Annotation
Scale Lock icon similar to the one for the Place Text
tool and dimensioning tools. When you set the Active
Cell to a cell that can be placed as an annotation cell,
the Annotation Scale icon should be enabled as shown
right.
The icon's tool tip tells you the active model's
annotation scale factor and the off/on state of the
Annotation Scale Lock. If this lock is on, the model's
Annotation Scale factor will be applied to the cell you
are placing. To turn on the Annotation Scale Lock,
click the icon.
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Note: If the Annotation Scale lock is off when placing cells in the design file the Annotation Scale
feature is ignored.
Cosmetic and Physical cells for plan graphics are specified in the CADD Information Table, Appendix A
and displayed in Appendix C along with the Cell Origins.
Recommendations for Scaling Cells on ODOT plans:
Basemap design files are used to draw existing and proposed plan view information for the entire length
of the project for both Roadway and Bridge projects. All basemap information shall be drawn in the
default Design model. The location and dimensions of all plan view basemap design file information shall
be drawn using real world dimensions at a 1:1 scale. Cells are to be placed in the basemap at a scale of
one (1), with the Place Active Cell’s Annotation Scale Lock toggled on so the Model Properties
Annotation Scale feature can be used.
When attaching the basemaps as References to the “Sheet” model, set the Model Properties Annotation
Scale for the appropriate sheet scale. Changing the Model Properties Annotation Scale value will cause
the display of the Cells to change according to the value selected. This will affect cells, text and
dimensions drawn in the active file, as well as referenced graphics depending on the settings when the
references were attached.
All cells should be placed at a scale of one (1), with the Place Active Cell’s Annotation Scale Lock
toggled on, and then scaled using the Model Properties Annotation Scale as shown below.
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The following procedures listed are based on the expanded features available in MicroStation. The final
decision regarding plan drafting and design is at the discretion of the designer.
206.4.1 Basemap
Manual Placement (Existing and Proposed):
Place all Cells in the basemap design file at a Scale of one (1.0), with the Place Active Cell
Annotation Scale Lock toggled on.

When working in the basemap, use the following procedure to set the Annotation Scale:
In the Model Properties dialog box, set the Annotation Scale to the appropriate Engineering
Scale desired.
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GEOPAK Placement (Existing and Proposed):
The GEOPAK Design and Computation Manager dialog box can be used to place cells in the
basemap using the default Design mode.

The Design mode is used to plot COGO elements into MicroStation with the desired symbology by
use of the Draw Plan and Profile dialog box. It can also be used to set drafting standards to be used
in conjunction with MicroStation’s element placement commands, with the Place Influence option
toggled on, as shown below:

When using the Design mode, the following procedure should be used to place Cells in the base map:

Before you begin placing MicroStation elements in
Design Mode, it is good practice to check the
Design Settings to ensure that the Cell
Creation’s Plot Scale value is set properly.
From the Design and Computation Manager
dialog box, select Settings > Design to access
the Design Settings dialog box shown at right.
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The following options related to Cell placement are available from or when using the Design Settings
dialog box:
206.4.2 Cell Creation
The default Plot Scale factor for placing cells is specified here. For ODOT plans, this value should
be set to one (1.0) to allow the Model Annotation Scale to control the cell scale.

Influence Graphic Cell Level Symbology
When active, the Influence Graphic Cell Symbology uses the symbology within the Design and
Computation Manager, ignoring the element symbology used when the cell was created. This option
should always be toggled off for ODOT plans.

The Annotation Scale is set as follows for Cells:

34

•

Select the Models dialog box.

•

From the Models dialog box, select Edit Model Properties to access the Model Properties
dialog box as shown below.

•

Set the Annotation Scale as desired.
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In the example shown, the Annotation
Scale is set to a value of Engr 1:20, with
the Line Style Scale value set to match
the Annotation Scale.

Notes:
•

The method described above is a change in procedure from previous MicroStation
releases.

•

The ODOT Design & Computation Manager Database for GEOPAK V8i has been specifically
modified to accommodate placing cells using the Model Annotation Scale. Previous
versions of ODOT.ddb will not allow the cells to be scaled using the Annotation Scale.

206.4.3 Survey Processing using the legacy GEOPAK Survey tools:
The GEOPAK Project Preferences dialog box is used to control how the Cells in the basemap will be
drawn. To use the Model Properties “Annotation Scale” feature, the Cells must be visualized at a
scale of one (1.0) as shown below:
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The Plot Scale item is used to control the size of the Cells, and Text used in the mapping of the
survey data. The base scale is defined for each feature code in the SMD file. The Plot Scale should
normally be set to a value of one 1.0 for all ODOT projects.
Text and cells placed by GEOPAK Survey are not automatically scaled until the annotation scale is
manually applied to the survey mapping.
To apply the model annotation scale to the Cells and Text, type the command Annotationscale Add
into the Key-in window inside MicroStation as shown.

This command will apply the annotation scale to all the cells and text in the model. The cells and
text will now take on the active model annotation scale value.
After the annotation scale has been applied to the cells and text in the file by use of the
Annotationscale Add command, you do not need to run the key-in command again for the cells and
text to honor changes to the model annotation scale.
Important Survey Processing Notes:
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•

If additional survey data is mapped to the same design file, it will be necessary to run
the key-in Annotationscale Add command again in order for the new data to honor the
current annotation scale value.

•

The display of the text, cell, and line styles can be controlled uniquely for reference
attachments. For example, the Survey Basemap file can be set with the model
annotation scale value necessary for the Surveyor. Designers may reference the file and
set the model annotation scale for a different value as needed for the plans without
altering the survey basemap.

•

The Annotationscale Add command will optionally work with a MicroStation selection
set. If no elements are selected when the command is processed, all cells and text in
the active model will be processed.

•

Care must be taken to ensure that elements other than the survey information are not
selected when the Annotationscale Add command is applied. For example, the text for
centerline stationing and curve data that is placed by the GEOPAK Design and
Computation Manager is placed for a specific plotting scale (this procedure will not
change). If you apply the Annotationscale Add command to these elements, they will
appear out of scale when the command is applied since they were not originally placed
at a scale of one (1).
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206.4.4 Survey Processing using OpenRoads Technology
Survey data processed using the OpenRoads Survey technology is drawn according to the current
MicroStation Annotation Scale setting and will respond to changes in the Annotation Scale value.
For more detailed information processing survey data using OpenRoads technology see the ODOT
GEOPAK Survey with OpenRoads Technology training guide.
206.4.5 Sheet Files
In the “Sheet” model, set the Model Properties Annotation Scale for the appropriate sheet scale.

Changing the Annotation Scale value will cause the display of the Text, Cells and Dimensions to
change according to the value selected. This will affect elements drawn in the active file, as well
as Referenced graphics, depending on the settings when the references were attached.
Important Notes when Referencing:
•

Be aware that if the Cells were placed in the basemap using a Scale factor other than a
Scale of 1, with the Cell Annotation Scale Lock on, the referenced cells will be scaled by
the Model Annotation Scale set in the new dgn file and will appear out of scale.

•

If the Model Annotation Scale is already set in the design file and the Model Annotation
Scale is set in the Reference at 1:1, the Detail Scale in the Reference Attachment
Settings dialog box displays the Model Annotation Scale and the Scale (Master:Ref)
displays a 1:1 scale like shown below:

•

Be aware if the Model Annotation Scale is already set in the design file and the Model
Annotation Scale is set in the Reference to anything other than 1:1. The Detail Scale in
the Reference Attachment Settings dialog box displays the Reference’s Model
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Annotation Scale. The Scale (Master:Ref) is then calculated from the referenced model's
annotation scale and the active model's annotation scale.
For example, if the Reference file has a Model Annotation Scale set to 1:20 and the
design file has a Model Annotation Scale set to 1:50, the Detail Scale displays the
Reference’s Model Annotation Scale (1:20) and the Scale (Master:Ref) is calculated 2.5:1
as shown below:

To avoid the Reference from scaling in the design file, like shown in the example above,
make sure the Scale (Master:Ref) is set to 1:1. If the Scale (Master:Ref) is not set to 1:1,
you will need to change it. Once you have set the Scale to 1:1, the Detail Scale will then
read the design file’s Model Annotation Scale that was set, as shown below:
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207 Fonts
207.1 General
ODOT has defined several standard fonts for use on all plans. It is important to use these fonts so that
the final plotted version matches the electronic version of the file. Only the fonts provided by ODOT
(30, 31, 57, and 70) are acceptable for use on ODOT plans. True Type fonts shall not be used on ODOT
Construction plans.
The ODOT standard font resource file, ODOT_Fonts.rsc, can be obtained from the ODOT CADD Standards
website. The MicroStation configuration variable MS_FONTPATH is used to specify the font library.
The following fonts are available in the ODOT standard font resource file, ODOT_Fonts.rsc:
Font 30 - Straight, proportional characters with uppercase, lowercase, and fractions. This font
is for general plan use and has the modified keystrokes set.
Font 31 - Slanted, proportional characters with uppercase, lowercase, and fractions. This font
is for general plan use and has the modified keystrokes set.
Font 57 – Straight, proportional characters with the Greek alphabet in upper and lowercase.
Font 70 - Block filled. This font is used on plan sheets when a bold title is necessary.
Modified keystrokes are used to generate certain symbols and special characters for Font 30 and Font 31
as shown in Appendix B. Font 57 and Font 70 are also shown for reference.
All text placed on Bridge sheets, excluding text contained in standard border cells, shall use Font 31.
All text placed on Geotechnical Exploration sheets, excluding text contained in standard border cells,
shall use Font 30 or Font 31. For purposes of this manual, the term “Geotechnical Exploration sheets”
shall apply to all sheets generated per the Specifications for Subsurface Investigations (SSI) or the
Specifications for Geotechnical Explorations (SGE).

207.2 Text Size
Standard text sizes have been defined to ensure uniform legibility of all plan sheets. Standard text size
refers to the size of the text on the finished plot, not the text size in the design file. The correct design
file text size is dependent upon the intended plot scale. ODOT standard text sizes for the finished plot
scale are shown in the following table:
Text Type

Plotted Text Size

Normal
Subtitle
Title

0.14”
0.17”
0.20”

Main Title

0.25”
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To calculate text size used in a MicroStation design file for various scaled plan sheets use this method:
(Text Size) x (Plotting Scale) = Design File Text Size
Example: 0.14 inch x 20 feet/inch = 2.8 feet
Text sizes smaller than the Normal text size are not acceptable.
For all Roadway plan sheets and Geotechnical Exploration sheets, the preferred method to set the text
size is by use of the Model Annotation Scale parameter. See Section 207.4 - Text Styles for more
information.
Text placed in the sheet model for bridge detail sheets should normally be placed at a scale of 1. For
more information on the use of design models and sheet models, see Section 303 - References.

207.3 Text Line Spacing
In general, Text Line Spacing should be one-half (0.50”) the text height. The spacing between lines on
summary, sub-summary, general note sheets and charts is generally equal to the minimum text size.

Note: If needed it is permissible to use Text Line Spacing equal to the minimum text size.
Text Line Spacing distances is now relative to the Text Height. In the previous versions of MicroStation
these distances were an absolute value in master units. If the text height changed dramatically, the
spacing could become inappropriate. Now, if the text height changes the spacing adjusts relative to the
change in the text height. The Text Line Spacing is now a factor of the Text Height.
For example, with the scale factor set at 0.50” (one-half) the Line Spacing for ODOT’s Text Styles would
be as follows:
Normal Text Size 0.14” x Line Spacing 0.50”
Sub-Title Text Size 0.17” x Line Spacing 0.50”
Title Text Size 0.20” x Line Spacing 0.50”
Main Title Text Size 0.25” x Line Spacing 0.50”

=
=
=
=

a Line Spacing of 0.07”
a Line Spacing of 0.085”
a Line Spacing of 0.10”
a Line Spacing of 0.125”

207.4 Text Styles
A MicroStation Text Style is a saved set of text parameters such as font type, text width, text height, color,
etc. Text styles enable you to place text in a consistent and automated manner. ODOT’s standard text
styles are defined in a MicroStation DGN Library, ODOT_Styles_TextDim.dgnlib, which can be obtained
from the ODOT CADD Standards website. This file is attached for use by the MicroStation configuration
variable MS_DGNLIB.
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The following Text Styles have been configured for use on ODOT plans:
Style Name

*Text Size

*Line Spacing

Font

0.25
0.20
0.17
0.14
0.14

0.50
0.50
0.50
0.50
0.50

70
70
70
31
30

Slanted-Normal FX Spacing
0.14
0.50
Slanted-Normal LS=0.50
0.14
0.50
Slanted-Normal LS=0.75
0.14
0.75
Slanted-Normal LS=1.00
0.14
1.00
Slanted-Sub Title
0.17
0.50
Slanted-Title
0.20
0.50
Straight-Normal FX Spacing
0.14
0.50
Straight-Normal LS=0.50
0.14
0.50
Straight-Normal LS=0.75
0.14
0.75
Straight-Normal LS=1.00
0.14
1.00
Straight-Sub Title
0.17
0.50
Straight-Title
0.20
0.50
*Text size and Line Spacing units are “inches”.

31
31
31
31
31
31
30
30
30
30
30
30

Font 70-Main Title
Font 70-Title
Font 70-Sub Title
Masked Slanted-Normal LS=0.50
Masked Straight-Normal LS=0.50

All text placed on Bridge sheets, excluding text contained
in standard border cells, shall use the “Slanted” text
styles.
The active text style can be selected in MicroStation prior
to placing text. Select the Place Text command to access
the following dialog box shown at right.
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Selecting a Text Style will set the text size appropriate for a 1:1 plot. To place text for other plotting
scales, users can automatically set the text size by setting the MicroStation Model Annotation Scale
before placing the text. From the MicroStation pull-down menu, select File > Models or select the
Models icon on the Primary Tools box, then select Edit Model Properties from the Models dialog box to
access the dialog shown:

The list of available annotation scales is defined in the ODOT Standard file ODOT_scales.def which can
be obtained from the ODOT CADD Services website. The MicroStation configuration variable
MS_CUSTOMSCALEDEF is used to assign the scale definition file.
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The following annotation scales have been defined in ODOT_scales.def:
Engineering Scales

Architectural Scales

Name

Scale

Name

Scale

Engr 1:1

1:1

Arch 12"=1'-0"

1:12

Engr 1:2
Engr 1:3
Engr 1:4

2:1
3:1
4:1

Arch 6"=1'-0"
Arch 3"=1'-0"
Arch 1 1/2"=1'-0"

1:6
1:3
2:3

Engr 1:5
Engr 1:6
Engr 1:8

5:1
6:1
8:1

Arch 1"=1'-0"
Arch 3/4"=1'-0"
Arch 1/2"=1'-0"

1:1
4:3
2:1

Engr 1:10
Engr 1:20
Engr 1:25

10:1
20:1
25:1

Arch 3/8"=1'-0"
Arch 1/4"=1'-0"
Arch 3/16"=1'-0

8:3
4:1
16:3

Engr 1:30
Engr 1:40
Engr 1:50

30:1
40:1
50:1

Arch 1/8"=1'-0"
Arch 1/16"=1'-0"
Arch 1/32"=1'-0"

8:1
16:1
32:1

Engr 1:100
Engr 1:200

100:1
200:1

Engr 1:250
Engr 1:400
Engr 1:500

250:1
400:1
500:1

Engr 1:1000
Engr 1:2000
Engr 1:5000

1000:1
2000:1
5000:1

Engr 1:10,000
Engr 1:25,000
Engr 1:50,000

10,000:1
25,000:1
50,000:1

Engr 1:100,000
Engr 1:250,000

100,000:1
250,000:1

Architectural scales are used for annotating bridge details when the text is placed in the design model
instead of the sheet model.
Engineering scales should be used for all Roadway sheets including the Bridge Site Plan sheet and
Geotechnical Exploration sheets.
See the Location and Design Manual, Volume 3 – Roadway Design, the Bridge Design Manual, and the
Specifications for Geotechnical Explorations (SGE) for recommended sheet scales.
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In order to apply the annotation scale to a Text Style, you must toggle on the Annotation Scale Lock in
the Place Text dialog box before placing the text. Select the Place Text command to access the dialog
box shown below:

In the example above, the ODOT, standard text style Slanted-Normal LS=0.50 has been selected with
the Model annotation scale set to Engr 1:20. The text size and line spacing will be set as follows:
Text Size:
Line Spacing:

0.14 inch x 20 feet/inch = 2.8 feet
0.50 inch x 2.8 feet = 1.4 feet
(Line Spacing is set to half the Text size)

Text Styles do not set the Level or Weight for the text placement. The text will be placed on the active
level with the active weight. All text placed using Text Styles established for Title and Sub-Title text
should be placed at a weight of 2.

207.5 Dimension Styles
Similar to Text Styles, a MicroStation Dimension Style is a saved set of dimensioning parameters. ODOT
has configured a set of dimension styles to be used on ODOT plans. These styles are defined in the ODOT
Standard DGN Library, ODOT_Styles_TextDim.dgnlib, which can be obtained from the ODOT CADD
Standards website. This file is attached or used by the MicroStation configuration variable MS_DGNLIB.
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The following dimension styles have been defined in ODOT_Styles_TextDim.dgnlib:
Dimension Style

Font

*Text Size

Description

Dec-0, Slanted

31

0.14

Decimal Feet, No decimal places

Dec-0, Straight
Dec-1, Slanted
Dec-1, Straight
Dec-2, Slanted
Dec-2, Straight
Dec-Multiline, Slanted
Dec-Multiline, Straight
Fract-Multiline, Slanted
Fract, Slanted
Masked Fract, Slanted

30
31
30
31
30
31
30
31
31
31

0.14
0.14
0.14
0.14
0.14
0.14
0.14
0.14
0.14
0.14

Decimal Feet, No decimal places
Decimal Feet, 1 decimal place
Decimal Feet, 1 decimal place
Decimal Feet, 2 decimal places
Decimal Feet, 2 decimal places
Decimal Feet, 0.01 accuracy
Decimal Feet, 0.01 accuracy
Fractions, 1/16” accuracy
Fractions, 1/16” accuracy
Fractions, 1/16” accuracy

Masked Fract-Multiline, Slanted
31
0.14
Fractions, 1/16” accuracy
XS-Intersection0Marker
30
0.0001
Used with OpenRoads Features
*Text size units are “inches”.
Line Terminators shall be a filled arrow created with a width to height ratio of 2.5:1. The terminator
width shall equal the text height.
Leader Lines may be broken when crossing dimension lines. In order to keep broken lines to a minimum,
it is recommended that the user relocate the dimension callout or reposition the dimension. Leader lines
and terminators shall be a weight of zero (0) and shall be placed on the same level as required for text
notes and callouts.
Similar to Text Styles, the text size for Dimension Styles can be set by use of the Model Annotation Scale
parameter. See section 207.4 Text Styles for more information.
The Multiline dimension styles have been configured to place dimension text above and below the
dimension line as shown at left in the example below. These Dimension styles have been provided to
allow the user to edit the dimension text to contain a label as part of the dimension element. This is
advantageous in the case where the dimension is moved or modified since the text is part of the
dimension and not a separate text string that must be moved manually. The MicroStation Edit Text
command is used to edit the dimension text. An example of the edited text is shown at right below:

Bridge plans shall use the “Fract, Slanted”, “Fract-Multiline, Slanted” or “Masked Fract, Slanted”,
“Masked Fract-Multiline, Slanted” dimension styles. All Bridge dimensions shall be placed associated.
Dimensions shall not have their status dropped.
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208 Seed Files
208.1 General
MicroStation uses a “seed file” to create all design files. A seed file is a template in which standard
parameters are set. Seed files do not typically contain elements, but like other design files they do
contain settings like working units and view configurations. Using a standard, customized seed file helps
maintain uniformity and keeps the user from having to adjust design file settings each time a file is
created.
The following two-dimensional (2D) and three dimensional (3D) seed files are available on the ODOT
CADD Services website. The Geographic Coordinate System (GCS) for each seed file is defined as shown
in the table below:
Dimension

Seed File Name

Geographic Coordinate System

2D

ODOTSeed2d.dgn

None

2D

ODOTSeed2d_OH83-2011-NF.dgn

OH83-2011-NF

2D

ODOTSeed2d_OH83-2011-SF.dgn

OH83-2011-SF

2D
2D

ODOTSeed2d_OH83-NF.dgn
ODOTSeed2d_OH83-SF.dgn

OH83-NF
OH83-SF

3D

ODOTSeed3d.dgn

None

3D

ODOTSeed3d_OH83-2011-NF.dgn

OH83-2011-NF

3D

ODOTSeed3d_OH83-2011-SF.dgn

OH83-2011-SF

3D
3D

ODOTSeed3d_OH83-NF.dgn
ODOTSeed3d_OH83-SF.dgn

OH83-NF
OH83-SF

The MicroStation configuration variable MS_DESIGNSEED is used to define the default seed file.

208.2 Models
ODOT’s seed files each contain two models as listed in the table below.
Model Name

Type

Design
Sheet

Design Model
Sheet Model

For more information on the use of models, see Section 303 - References.
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209 GEOPAK Design and Computation Manager Database
209.1 General
The primary purpose of the GEOPAK Design and Computation Manager (D&C Manager) is to assist the user
with the placement of MicroStation elements according to a set of predefined CADD standards.
ODOT provides a standard D&C Manger database, ODOT.ddb that has been configured according to the
CADD standards outlined in this manual. The ODOT.ddb can be obtained from the ODOT CADD Services
website.
The D&C Manager can be used to facilitate the placement of curvilinear features or point features
represented by cells according to ODOT standards. For more information on the use of the GEOPAK
Design and Computation Manager, see the ODOT GEOPAK Road 1 Training Guide on the ODOT CADD
Services website.
Users are not permitted to edit the ODOT.ddb.

210 GEOPAK Survey Manager Database
210.1 General
The GEOPAK Survey Manager Database is primarily used to assist the user with mapping field survey codes
to the appropriate MicroStation symbology according to a predefined set of CADD Standards and Survey
field codes.

210.2 Survey Field Codes
ODOT has developed a set of standardized field codes for all survey data submitted to the Department.
The list of standard field codes for ODOT projects can be obtained from the ODOT CADD Services
website.
The field code list is available in PDF format in the \ODOTcadd\Standards\Geopak\Survey\Field_Codes
folder.
Users are not permitted to use other field codes to supplement the ODOT code list for any project related
survey data submitted to or exchanged with ODOT.

210.3 Survey Manager Database
ODOT has developed a standard Survey Manager Database, ODOT.smd, for use with GEOPAK Survey
Software to map the field codes contained within a set of survey data to the appropriate symbology in a
MicroStation design file according to the CADD Standards set forth within this manual. The ODOT.smd
can be obtained from the ODOT CADD Services website.
Users are not permitted to edit ODOT.smd.
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The OpenRoads Survey tools use an XML file that has been exported from the ODOT.smd file to facilitate
mapping the survey data according to ODOT’s CADD Standards. The ODOT_SMD.xml file can be obtained
from the ODOT CADD Services website.

211 Working Units
211.1 General
MicroStation lets you draw in "real world" units; feet, inches, meters, etc. These real world units are
called working units. Working units are expressed as Master Units (the largest units in common use in a
design file, such as feet) and fractional Sub Units (such as inches).
The default definition for a foot in MicroStation is the International Foot. The U.S. Survey Foot definition
can be defined by use of a unit definition file. ODOT has developed a standard unit definition file,
ODOT_Units.def, to define the U.S. Survey Foot as the standard Master Unit. This file can be obtained
from the ODOT CADD Services website. The active unit definition file is specified by the configuration
variable MS_CUSTOMUNITDEF.
MicroStation design files used in plan preparation shall use the following standard working units as
defined in the ODOT seed files and in ODOT_Units.def:
Unit Names
Master Unit: Survey Feet
Sub Unit: Inches

Label
‘
“

The ODOT seed files have been defined with a standard resolution setting of 12000 per Survey Foot. This
setting shall not be changed by the user.
ODOT’s seed files are set up with the standard working units described above. Deviation from these
working units is not permitted.

212 Global Origin
212.1 General
Elements in the design file are drawn by placing data points. Each data point placed in the design plane
has associated X (easting), Y (northing) and Z (elevation, 3D files only) positions or coordinates. The
design plane is simply a Cartesian coordinate system upon which your design model lies.
In the ODOT Seed files, the point called the Global Origin is set to the design plane's exact center
(178,956.9707, 178,956.9707) and assigned the coordinates 0,0 (2D files) and 0,0,0 (3D files).
The Global Origin is defined in ODOT’s Seed Files and should never be changed for ODOT projects.
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213 Custom Applications
213.1 General
ODOT has written several programs to assist the user with specific CADD related functions. Each
application can be accessed from the main menu bar under the ODOT pull-down menu. The ODOT pulldown menu has been configured to group the applications logically.
A detailed list of applications including documentation is available on the ODOT CADD Services website
for download.
ODOT’s pull-down menu for applications is defined in a MicroStation DGN Library, ODOT_Menu.dgnlib,
which can be obtained from the ODOT CADD Services website. The DGN library is attached by use of
the MicroStation configuration variable MS_DGNLIBLIST.

214 GEOPAK Criteria Files
214.1 General
Criteria files are ASCII text files written in the GEOPAK Criteria language. Criteria files are primarily
used to draw proposed cross section graphics in a MicroStation design file.
Three Port Criteria (3PC) commands can be used to extend the processing capabilities of GEOPAK Criteria
to draw MicroStation elements in a plan, or profile, design file in addition to the cross section design
file. For ODOT purposes, criteria files that are processed from the GEOPAK Design and Computation
Manager to draw plan or profile information are referred to as “3PC files”. Criteria files that are
processed from cross section mode are referred to as “criteria files” even though the cross section
criteria file may contain 3PC commands to draw elements in the Plan or Profile design files.
NOTE: ODOT’s Criteria Files are provided as-is. Changes and revisions to ODOT’s criteria files are no
longer supported.

214.2 Cross Section Criteria Files
ODOT has developed a set of criteria files to assist the user with the drawing and detailing of the proposed
cross sections. These criteria files are available on the ODOT CADD Services website.
The ODOT cross sections criteria files have been developed according to the standards defined in the
Location and Design Manual, Volume 1 – Roadway Design. These criteria files are provided as a
convenience to the user and are not intended to draw all aspects of every cross section correctly. The
designer must take care to review the results and make any modifications necessary to the cross section
graphics to ensure compliance with ODOT design standards.
Cross Section Criteria files shall have an .x file extension.
Users are permitted to copy and modify the criteria files as necessary to achieve the desired results.
Modified criteria files should be renamed to avoid confusion with the ODOT standard criteria files. All
new or modified criteria files shall be submitted to ODOT with the completed project data. Refer to
ODOT’s Guidelines for Electronic Design Deliverables for more information.
As a standard practice, users should copy all cross section criteria files used on the project to the
project’s \Design\geopak\criteria sub-directory. See Section 302 - Project Directory Structure for
information on project directories.
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214.3 3 PC Criteria Files
ODOT has developed various 3PC applications, which are used in conjunction with the GEOPAK Design
and Computation Manager. These applications can be obtained from the ODOT CADD Services website.
Three Port Criteria files run from the GEOPAK Design and Computation Manager shall have a .3pc file
extension.
The configuration variable GPK_DC_3PCDIR is used to specify the directory location containing the 3PC
applications.
Users are permitted to copy and modify the 3PC criteria files as necessary to achieve the desired results.
Modified 3PC criteria files should be renamed to avoid confusion with the ODOT standard criteria files.
All new or modified criteria files shall be submitted to ODOT with the completed project data.
As a standard practice, users should store new or modified 3PC criteria files in the project’s
\Design\geopak\criteria\3pc sub-directory. See Section 302 - Project Directory Structure for
information on project directories.

214.4 Cross Section Input Files
Cross sections can be processed in GEOPAK through a dialog box interface by use of the GEOPAK Project
Manager, or by an ASCII input file.
All cross section input files used on the project shall be submitted to ODOT. Refer to ODOT’s Guidelines
for Electronic Design Deliverables for more information. Input files shall be stored in the project’s
\Design\geopak\input sub-directory.
Cross Section input files shall use relative paths where applicable.

215 OpenRoads Standards
215.1 General
The ODOTcadd Standards include several new standard files defined for use with Bentley’s OpenRoads
technology.

215.2 DGN Libraries
Several MicroStation DGN Libraries have been configured within the ODOTcadd workspace, for use with
Bentley’s OpenRoads Technology, as detailed below.
ODOT_DesignProjectSettings.dgnlib
This DGN Library contains default settings for the OpenRoads Civil Standards. The settings can
be reviewed from the MicroStation Project Explorer by selecting Civil Standards > Project
Settings. Two groups of settings are defined by this DGN Library: Corridor Design Stages and
Linear Template Design Stages. This file is included by use of the MicroStation Configuration
Variable CIVIL_PROJECTSETTINGSDGNLIBLIST.
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ODOT_DesignStandards.dgnlib
This DGN Library defines the Design Standards for Horizontal and Vertical alignments according
to various standards defined in the Location and Design Manual, Volume 1 – Roadway Design.
The settings can be reviewed from the MicroStation Project Manager by selecting Civil Standards
> Design Standards > Vertical or Civil Standards > Design Standards > Horizontal. This file is
included by use of the MicroStation Configuration Variable CIVIL_DESIGNSTANDARDSDGNLIBLIST.
ODOT_Features_Design.dgnlib
This DGN Library defines OpenRoads Features for design as well as the MicroStation Element
Templates. The Element Templates are included in the ODOTcadd configuration by use of the
variable MS_DGNLIBLIST. The OpenRoads Features are included in the ODOTcadd configuration
by use of the variable CIVIL_CONTENTMANAGEMENTDGNLIBLIST.
ODOT_Features_Survey.dgnlib
This DGN Library is used for multiple purposes. The file defines the OpenRoads Survey field codes
which in turn use the file ODOT_SMD.xml to define the various parameters for each feature code.
The DGN Library also defines Features for Terrain Model visualization. The OpenRoads Features
are
included
in
the
ODOTcadd
configuration
by
use
of
the
variable
CIVIL_CONTENTMANAGEMENTDGNLIBLIST.
The DGN Library also defines the default Survey Settings for OpenRoads. These settings can be
reviewed from the MicroStation Project Explorer by selecting Civil Standards > Project Settings
> Survey > Settings. The configuration variable CIVIL_PROJECTSETTINGSDGNLIBLIST is used to
include these settings in the ODOTcadd workspace.

215.3 Template Libraries
Bentley’s OpenRoads technology uses Templates to define the cross sections of the proposed roadway.
These templates are applied to a design corridor to create a 3-dimensional model of the proposed design.
ODOT provides a template library, ODOTcadd_Templates.itl, with several cross section components that
can be used as a starting point to design the typical sections for the proposed roadway corridor.
ODOTcadd_Templates.itl is located in the following folder:
\ODOTcadd\Standards\Geopak\Road\templates
The normal practice is to copy the template library from the standards to the \Design\Geopak folder
for each project. The copied template library should be renamed as follows:
nnnnnn_Templates.itl

Where:
nnnnnn

= The five (5) or six (6) digit PID number for the project.

The template library can be included in the configuration by use if the MicroStation Configuration
Variable CIVIL_ROADWAY_TEMPLATE_LIBRARY; however this variable is undefined in the ODOTcadd
workspace since the Template library will be unique for each project. The MicroStation Project
Configuration File (PCF) is used to define project specific variables. See Section 302.2 - Project
Configuration Files.

ODOT CADD Engineering Standards Manual (ODOTcadd)

51

July 20, 2018

300 FILE MANAGEMENT
301 General
301.1 General
File management refers to how documents are organized and stored. Its primary purpose is to provide a
safe repository for information and to minimize the possibility of that information being lost.
This section documents changes to ODOT’s File Management standards to be used with projects started
after January 16, 2015, using MicroStation and GEOPAK (SELECTseries 4) or greater, and using the
“ODOTcadd” standards.
Projects started prior to January 16, 2015 should be completed using the file management standards
defined for ODOTstd\V8istd.
The January 16, 2015 update represents the last update to ODOT’s legacy ODOTstd CADD Standards.

302 Project Directory Structure and Project Configuration Files
302.1 Standard Directory Structure
A standard project directory shall be used to house all project related data for the various workflows
involved in the project development process throughout the lifecycle of the project.
Alphanumeric characters, a dash “-“, an underscore “_”, or a period “.” are the only characters
permitted in folder names. No other special characters, or spaces, are permitted in any folder name.
A standard project directory structure for projects started after January 16, 2015, using the ODOTcadd
Standards, shall consist of a main directory on the server named “ProjectData”.
Under the ProjectData directory, an optional sub-directory may be created with the three (3)-letter
character of the County (County codes are defined in the Location and Design Manual, Volume 3,
Section 1302.2.2.1) in order to separate the projects by County if desired.
Under the optional County sub-directory, or directly under the ProjectData folder, a sub-directory will
be created using the five (5) digit ODOT Project Identification Number (PID) and will contain all project
related information. The PID number folder is considered the primary folder for the project.
An optional 15-character supplemental description may be added to the PID number if desired, separated
from the PID number by an underscore “_” character. The supplemental description is intended to assist
users in finding the project data when the PID number is not known. Typically, the description is used to
identify the primary county route and section of the plan as identified on the Title sheet. Alphanumeric
characters, a dash “-“, an underscore “_”, or a period “.” are the only characters permitted in the
supplemental description. No other special characters or spaces are permitted in any folder name.
Each ODOT District office or consulting firm should be consistent with use of the optional County subdirectory. For example, do not mix and match folder structures with some projects placing the PID folder
under the County folder and some projects placing the PID folder directly under the ProjectData folder.
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Example using a County sub-directory

Example with an optional description and
without a County sub-directory

Beneath the PID number folder, five sub-folders are defined representing various workflow processes for
the project. The following folders are defined:

302.1.1 The Design folder
The Design folder is used to house all project related data used for the generation of the construction
plans for the project, from planning to final design.
Multiple discipline-specific sub-directories may be used to separate the roadway design information
into separate folders. For small projects, a minimum of two folders are required under the Design
folder; Roadway, and Standards. If the project includes field survey work, a Survey sub-directory
shall be used for that information. GEOPAK related files shall be stored in the Geopak sub-directory.

For larger projects involving multiple design teams, it is sometimes desirable to use an expanded
directory structure to split the roadway design information into separate discipline specific subdirectories. This expanded folder structure will allow each design team to set file permissions to
restrict access to their data, as needed.
The discipline sub-directories will be defined for the division of work by ownership, not necessarily
the type of work. As files are developed by the various disciplines, they should generally be placed
into the project sub-directories corresponding to the creator of the work. For example, Roadway
design would typically place their files under the Roadway sub-directory, Surveyors would place their
files under the Survey sub-directory, and so forth.
In design, there may be instances where one discipline’s work overlaps with another. If a particular
discipline requires information from another discipline, or shares files with multiple disciplines, the
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needed files should be referenced from the original directory and not copied (see Section 303 References).
The Roadway folder is considered the default folder for the project if a discipline specific folder is
not defined. For example, if a designer develops the drainage sheets for a project where discipline
specific folders have not been defined, by default, the files produced would go in the Roadway subdirectory. However, if so desired, the designer has the ability to create a Drainage sub-directory
and move the files there at a later time. In making the determination of which discipline’s subdirectory the file should be placed, the designer must use common sense.
In some cases, it will be advantageous to create non-standard directories for additional separation
of work. This is common when multiple parties work on a single discipline design and the data must
be managed and merged. These additional directories can be created under the discipline specific
subdirectories to accommodate such circumstances. Do not create these subdirectories at the same
level as the standard discipline subdirectories.
Figure 302-1.1
Design Directory Structure
Notes:
Optional folder for drainage design.
See Figure 302-1.2 for sub-directories.
Parent folder for all GEOPAK specific files.
Geopak**
See Figure 302-1.3 for sub-directories.
Optional folder for geotechnical information.
Geotechnical
See Figure 302-1.2 for sub-directories.
Optional folder for landscape.
Landscape
See Figure 302-1.2 for sub-directories.
Optional folder for lighting.
Lighting
See Figure 302-1.2 for sub-directories.
Optional folder for maintenance of traffic.
MOT
See Figure 302-1.2 for sub-directories.
Required Folder for Roadway Design information.
Roadway*
See Figure 302-1.2 fir sub-directories.
Optional Folder for projects with Right-of-Way
RW
Acquisition
See Figure 302-1.4 for sub-directories.
Optional folder for signals.
Signals
See Figure 302-1.2 for sub-directories.
Parent folder for project specific standards used during
Standards*
project development.
See Figure 302-1.7 for sub-directories.
Optional folder for bridge and wall design.
Structures
Required for projects with work on more than one bridge
or wall. See Figure 302-1.5 for sub-directories.
Parent folder for survey information.
Survey***
See Figure 302-1.6 for sub-directories.
Optional folder for traffic control.
Traffic
See Figure 302-1.2 for sub-directories.
Optional folder for utility information.
Utilities
See Figure 302-1.2 for sub-directories.
* Required Folder for all projects
** Required folder if GEOPAK is utilized for design or survey
*** Required folder is survey related field work is preformed
Drainage

54

ODOT CADD Engineering Standards Manual (ODOTcadd)

July 20, 2018

Figure 302-1.2
Design\Discipline Specific Sub-Directories
Notes:
Discipline

Where Discipline = the following sub-directories:
Drainage, Geotechnical, Landscape, Lighting,
Roadway, Signals, Traffic, Utilities.

Basemaps

Basemap design files for the discipline.

EngData

Design documents, spreadsheets, or application data.

Images

Any digital or scanned images.

Sheets

Plan sheet MicroStation design files for the discipline.

MOT,

Figure 302-1.3
Design\GEOPAK Sub-Directories
Notes: The GEOPAK Project Manager creates additional sub-directories as
required by the software.
Geopak

GEOPAK related files including the .gpk and .prj files

Basemaps

OpenRoads Civil Geometry basemap design files

Criteria

Custom criteria files used for the project.

3pc

Customized three port criteria files used for the project.

Input

COGO input files.

Output

COGO output files.

Figure 302-1.4
Design\RW Sub-Directories
Notes:
Basemaps

Right-of-Way basemap design files.

EngData

Design documents, spreadsheets, or application data.

Images

Any digital or scanned images.

Legal

Legal descriptions for all property takes.

Closures

Survey closures for all the property takes.

Sheets

Plan sheet MicroStation design files.
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Figure 302-1.5
Design\Structures Sub-Directories
Notes:
The use of the Structures folder is optional. For smaller projects with
minimal bridge or wall work on only one bridge or wall, and where
the designer will be preparing the plan details, bridge and wall design
data may be stored in the Roadway folders.
For larger projects involving more than one bridge or wall, a separate
Structures folder is required with sub-directories for each bridge and
wall.

AAA000_1111S

Parent folder for bridge data, where:
AAA = 3 character county code
000 = 3 digit Route number
1111 = 4 digit SLM of the structure without the decimal
point.
S = 1 digit code (For twin structures: L for Left, R for
Right. C for collector/distributor roads or twin structures
combined in the same directory, P for Ramps.)

Wall_111

Parent folder for wall data, where:
111 = 3 alphanumeric character wall number

Basemaps

All bridge related basemap design files.

EngData

Design documents, spreadsheets, or application data.

Images

Any digital or scanned images.

Sheets

All structure related plan sheet design files.

Figure 302-1.6
Design\Survey Sub-Directories
Notes:
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Aerial

Aerial mapping design files and images

Basemaps

Basemap design files.

Docs

Documents, letters, memos, etc…

EngData

Design documents, spreadsheets, or application data.

GCS

Custom MicroStation Geographic Coordinate System
Definitions

GPS

GPS data

Images

Scanned images.

RawData

Raw survey data.

ODOT CADD Engineering Standards Manual (ODOTcadd)

July 20, 2018

Figure 302-1.7
Design\Standards Sub-Directories
Notes: This sub-directory is primarily used for project archiving and
electronic submission. During project development, ODOT users should
always reference all CADD Standards from the main CADD Standards
directory. Project specific standards, such as seed files, plot drivers, etc.
shall be stored in the Standards folder.
cell
Cell Libraries
config

Configuration files

ctb

Color Tables

dgnlib

DGN Libraries

macros

MicroStation Basic Macros

mdlapps

MDL Applications

office

Standard template for the project index file

plotdrv

Plot drivers

seed

Seed files

symb

Symbology .rsc files

tables

Pen tables

vba

Visual Basic Applications

302.2 Project Configuration Files
302.2.1 Project Configuration File Name
MicroStation Project Configuration Files (PCF) are used to define configuration variables that require
a unique value for a specific ODOT project. With the release of the January 2015 CADD Standards,
ODOT began using a PCF file for each project started with the ODOTcadd standards.
PCF files shall be housed in a folder named “ProjectPCF”. This folder is typically located on the same
shared network drive as the “ProjectData” folder described in Section 302.1 – Standard Directory
Structure.
PCF files shall be named using the following convention:
XXX_nnnnnn_description.pcf
Where:

XXX
nnnnnn
description

= An optional the three letter county code as defined in the Location and
Design Manual, Volume 3, Section 1302.2.2.1)
= The five (5) of six (6) digit PID number for the project.
= An optional description, 15 characters maximum.

An optional description may be added to the PCF file name similar to the optional description that is
permitted for the project’s PID folder name. If a description is included, it shall be separated from
the PID number by an underscore “_” character and may consist of alphanumeric characters, a dash
“-“, an underscore “_”, or a period “.” character. The description is intended to be used to identify
the primary County, Route, and Section of the plan as identified on the title sheet and should match
the description used for the project folder name.
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Example PCF file name with optional description: 111111_AAA-111-12.34
302.2.2 Project Configuration File Content
The content of the PCF file will vary for each individual project. An example of a typical PCF file is
shown below:
_USTN_PROJECTDESCR = ODOT Project 111111_AAA-111-12.34 #Project Description
_USTN_PROJECTDATA = C:/ProjectData/111111_AAA-111-12.34/Design/
ODOT_PROJECTROOT = $(ODOT_PROJECT)
ODOT_PID = 11111
#---------------------------------------------------------------------MS_DEF = $(_USTN_PROJECTDATA) #Project Location Start
MS_BACKUP = $(_DGNDIR)

#Backup to same location as dgn

MS_SEEDFILES = $(_USTN_PROJECTDATA)Standards/seed/ # Search Directory for Project Specific Seed files.
MS_GEOCOORDINATE_USERLIBRARIES = $(_USTN_PROJECTDATA)Survey/GCS/111111_Custom.dty
CIVIL_ROADWAY_TEMPLATE_LIBRARY = $(_USTN_PROJECTDATA)Geopak/111111_Templates.itl
MS_PRINTDEF_PATH = $(_USTN_PROJECTDATA)Standards/plotdrv/
MS_PLTFILES = $(ODOT_PROJECTROOT)ProjectAdmin/PlanPackage/ # Output Directory for Print Files.
MS_REF_DEFAULTATTACHDIRECTORY = $(_USTN_PROJECTDATA) # Set the default directory when attaching references
instead of the last directory
%lock MS_PLTFILES
%lock MS_SEEDFILES
%lock MS_DESIGNSEED
%lock MS_GEOCOORDINATE_USERLIBRARIES
%lock CIVIL_ROADWAY_TEMPLATE_LIBRARY
#----------------------------------------------------------------------
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302.2.3 Using Project Configuration Files
With the use of PCF files, users should always access MicroStation via the Windows Start Menu in
order to select the appropriate Project, as shown in the example below. Note: Double-clicking the
file name in Windows Explorer will access the last project that was selected.

302.3 ODOTcadd_CreateNewProject.exe
ODOT provides a custom program, ODOTcadd_CreateNewProject.exe that can be used to create the
project directories and the PCF file for the project. This program is available on the ODOT CADD
Standards website.
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303 References
303.1 General
References are used to display the contents of one or more MicroStation design files within the active
design file.
The most common use of references is to display Basemap design file information (See Section 303.3 Basemap Design Files) in a Sheet design file (See Section 303.4 - Sheet Design Files) to generate the
various plan sheets used by a typical ODOT roadway project.
References are also used to display the contents of one basemap design file in another basemap design
file to facilitate the design process (i.e. display the existing survey data in the proposed right-of-way
basemap).

303.2 Models
A Model is a 2 or 3 dimensional drawing area that is stored in a design file. A single design file can
contain multiple models, which means you can have multiple, independent, drawing areas in a single
design file. Each model has its own set of view parameters, working units, reference attachments, etc.;
however all models within the same design file share the same Color Table and Background Colors. Users
can only edit one model at a time in a design file.
To manage the model’s properties in a DGN file open the Models dialog box. This dialog box contains
tools that not only allows the user to edit the model’s properties but also allows the user to create, copy,
import, delete and open specific models in the DGN file.
The Models dialog box can be accessed several ways:
Key in: model manager
or
Select File > Models from the Main Menu bar.
or
Select the Models icon in the Primary Tools box.

The Models dialog box contains various tools that allow the user to work with models. See the
MicroStation documentation for complete information. Only items specific to the ODOTcadd Standards
are discussed here.
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Double-clicking a Model within the dialog box makes the model active. Alternatively, you can use the
View Groups window to rapidly switch between models visited in the current design session as shown
below:

303.2.1 Types of Models
Different types of models are available in MicroStation. The model types are Design, Drawing and
Sheet. The Design and Sheet models are used by ODOT for creating all new models. ODOT does not
currently use the Drawing model.

•

Design – model is used for creating design geometry that can be either 2D or 3D. All basemap
information shall be drawn in the default design model. See Section 303.3 - Basemap Design
Files for more detailed information.

•

Drawing – model serves as a Drawing Area for centralizing annotations that need to be shared
across multiple sheets. A drawing model is always a 2D model. ODOT does not use the
Drawing model at this time.

•

Sheet – model is used to assemble the plan sheets that are used for plotting a set of plans
that can be either 2D or 3D. Sheet border cells and annotations are placed in the Sheet
model. See Section 303.4 - Sheet Design Files for more detailed information.

303.2.2 Model Names
When creating a new design file using one of ODOT’s seed files, a Design and Sheet models are
already created for your use, as follows:
ODOT has a recommended standard for naming models when developing a set of plans. ODOT
Applications utilize the Model name “Sheet” except for cross sections. The GEOPAK Cross Section
attachment options do not provide the capability to generate each cross section sheet in a separate
design file, see the ODOT GEOPAK V8i SELECTseries 1, Road 2, Training Guide - Chapter 10 for
details. The model name “*Sheet*” as provided by ODOT’s seed files is utilized by ODOT’s plotting
software.
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Therefore, it is strongly recommended not to change the model names in the design files since the
programs and or software are dependent on the model names. Any name changes to the models
could prevent the application(s) from working properly.
For detailed information on how models are set up for Plan and Profile sheets and Cross Section
Sheets see the ODOT GEOPAK V8i Road 1 and 2 Training Guides.
303.2.3 Model Properties
You can review or edit properties of a model in the open design file by choosing the Edit Model
Properties icon on the Models dialog box. The model properties are different depending on what
type of model is selected, Design, or Sheet, as shown below:

“Design” Model Properties

“Sheet” Model Properties
See the MicroStation documentation for complete information. The items specifically related to the
ODOTcadd Standards are discussed here.
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•

Type - sets the model's type (Design or Sheet) and dimensionality (2D or 3D). See Section
303.3 - Basemap Design Files, and Section 303.4 - Sheet Design Files, for information on
the use of Sheet and Design models.

•

Name – is a text field to enter a name for the model. See Section 303.2.2 - Model Names.

•

Annotation Scale - sets the scale for text, dimensions and cells in the model. You can
select from the list of common scales used for ODOT plan sheets. When placing text,
dimensions and cells the Annotation Lock in the tool settings window must be on to ensure
that they are placed at the defined scale. The list of common scales is located from the
ODOT_Scales.def file located in the /ODOTcadd/Standards/data directory.
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•

Line Style Scale - Lets you set the scale for custom line styles. For most ODOT sheet types
the Line Style Scale is set to Annotation Scale.

Sheet Properties:
•

Sheet Name – Lets you assign a name to the sheet model. ODOT’s plot configuration files for
a multi-page PDF plan submission use the Sheet Name that is assigned here as the bookmark
name in the PDF file.

•

Sheet Number – Lets you assign a sheet number to sheet models. This makes it easy to
control the order of sheet models for presentation, printing, cataloging in a project, or
generating PDFs. The Sheet Number field is strictly limited to integer values only.

•

Display Sheet Boundary – If toggled on, a sheet element will display in the new sheet model.
The Sheet Boundary option must be toggled on in order to use the Sheet Name and Sheet
Number when generating a multi-page PDF document for the plan set using ODOT’s plot
configuration files.

•

Border Attachment - When you associate a border attachment to a sheet model, any changes
to the annotation scale for the sheet, automatically are propagated to the border
attachment. The Border Attachment parameter is normally set to “None” for ODOT projects.
o
o
o

Size - sets the sheet size.
Origin - sets the origin of the sheet.
Rotation - sets the rotation angle of the sheet, measured in degrees counterclockwise from the x-axis (horizontal).

303.2.4 Referencing Models
When selecting a reference to attach, users must select the appropriate model, Design or Sheet, in
a design file. A Design or Sheet model can be attached as a reference to the currently active model
in the open design file or in other design files. See Section 303.3 - Basemap Design Files and
Section 303.4 - Sheet Design Files.

303.3 Basemap Design Files
Basemap design files are used to draw existing and proposed plan view information for the entire length
of the project for both Roadway and Bridge projects. All basemap information shall be drawn in the
default Design model. The location and dimensions of all plan view basemap design file information
shall be drawn using real world dimensions at a 1:1 scale.
For Roadway projects, the most common basemap design files are as follows:
•
•
•
•

One containing the existing information (typically from ground survey or Aerial mapping).
A second containing the proposed roadway information.
A third containing the proposed Right-of-Way information. Existing Right-of-Way information
may be in the same file with the proposed Right-of-Way information.
If OpenRoads Horizontal Geometry tools are used, these alignments are typically stored in their
own basemap design file.
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Plan view information may be separated into multiple discipline-specific basemap design files as listed
below:
Allowable Plan View Basemap Files
Aerial mapping
Bridge
Drainage
Environmental
Existing Ground Survey
Geometry
Geotechnical
Landscaping
Lighting
Maintenance of Traffic
Proposed Roadway
Right-of-Way
Signals
Traffic Control
Utilities
Walls

If a bridge basemap is used, a separate basemap design file is required for each bridge on the project.
A basemap is also used for profiles and cross section graphics. Unlike plan view basemap files, profile
and cross section basemap design files shall contain both the existing and proposed information in one
file.
The profile basemap may be used to plot all the profiles for the entire project in one file. It is not
necessary to create separate profile basemaps for each alignment in the project. Profiles should always
be plotted in their own design file and never combined with any other basemap. After generating the
profile basemap, do not delete the profile cell. The profile cell is placed on the level “GK_Cells” as
defined by the Configuration Variable GPK_LEVEL_PROFILE_CELL and can be toggled on or off using the
MicroStation Level Manager, if required. If the configuration variable is not defined, the profile cell is
placed on the level “Default”.
A separate cross section basemap should be used for each alignment in the project. Cross sections for
multiple alignments should never be plotted in the same cross section basemap. Cross sections should
always be plotted in their own design file and never combined with any other basemap. After generating
the cross sections, do not delete the cross section cells. Cross section cells are placed on the “GK_Cells”
level as defined by the Configuration Variable GPK_LEVEL_XS_CELL and can be toggled on or off using
the MicroStation Level Manager, if required. If the configuration variable is not defined, cross section
cells are placed on the level Default.
When discipline specific sub-directories are used, as defined in Section 302.1.1 – The Design Folder, all
basemap design files shall be stored in the appropriate discipline specific basemaps sub-directory and
shall not be copied into another sub-directory for editing or referencing. If discipline specific subdirectories are not used, the basemap design files shall be stored in the Roadway\basemaps folder.
See Section 302.1 - Standard Directory Structure, for guidance on maintaining Survey Basemaps for
Roadway and Bridge Projects.
Standard design file names for Basemaps are detailed in Section 304.3 - File Name Format.

64

ODOT CADD Engineering Standards Manual (ODOTcadd)

July 20, 2018

303.4 Sheet Design Files
Sheet design files are used to assemble the plan sheets that are used for plotting a set of plans. The
Sheet design files are assembled by referencing Design models from the necessary basemap design files
to the sheet model of the sheet file. Sheet border cells and annotation are typically placed in the sheet
model.
For Roadway projects, including the Bridge site plan and Geotechnical Exploration sheets, when attaching
basemap Design models to the Sheet models the user shall not scale, move, or rotate the basemap
reference attachment. Basemap Design models shall be attached using the MicroStation CoincidentWorld setting. If a rotated plot view is required, the user shall rotate the sheet design file view for
proper plot orientation. The sheet border cells shall be placed in the rotated view. All reference file
clipping shall be done in the rotated view.
For Bridge sheets, a single design file may include both existing and proposed plan view information.
When developing Bridge profiles (including profiles for culverts greater than 10 feet in diameter or span),
place the profile in a design model. Reference the profile from the Design model into the Sheet model
(Site Plan or Culvert Detail sheet). All profile labeling shall be completed in the Sheet model.
Final plan sheets shall be in the Sheet Model. No items other than what is shown on the final plotted
sheet are allowed to be shown in the Sheet Model. Any detail shown in the final plotted sheet shall be
represented at a 1:1 scale in either the Design model or Sheet model of the corresponding file.
The purpose of having the existing details drafted, or referenced, at a 1:1 scale is to facilitate the
electronic transmission of design data (via email or equivalent) without providing the entire project
directory. If necessary, the designer can merge the referenced details within the design file.
Each plan sheet shall be contained within the Sheet Model. Only one plan sheet per model is permissible
for all file types, including cross sections. Users may elect to create multiple sheet models in a sheet
design file. Only sheets of a like type are permitted in a multi-model sheet design file. For example, it
is not permissible to create a design file containing the title sheet in one model and the schematic plan
in a second model. For multi-sheet design files, the first sheet model is named “Sheet” as defined in the
ODOT seed files. Subsequent sheet models should be named consecutively; Sheet2, Sheet3, Sheet4, etc.
The models in a multi-model cross section sheet design file generated by use of GEOPAK are named
automatically by the software and start with a prefix of “XS_SHEET_”.
When sheet design files are submitted to the Department, no other graphics are permitted in the Sheet
model other than the graphics representing the final plotted sheet. All extra graphics used to generate
the sheet, or old versions of the sheet, should be deleted or moved to a design model. No extra reference
attachments that are not a part of the final sheet are permitted to be attached to the sheet model.
In order to ensure that reference file attachments are maintained when moving project files from the
original project directory to another location, such as a CD for submission or to an archive directory,
references shall be attached using relative paths. The user shall not use MicroStation or GEOPAK options
to “Save Full Path” for reference attachments.
All completed sheet design files submitted to or exchanged with ODOT shall use references where
applicable. It is not recommended that users copy referenced graphics into the sheet files for the
completed sheet design files submitted to ODOT.
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304 File Naming Conventions
304.1 General
The efficient sharing and transfer of information from consultants/contractors to ODOT and vice versa
relies on the use of a systematic file naming convention. This section outlines a consistent,
comprehensive file naming convention for graphic and associated files used in the CADD environment,
which shall be used for all projects.
With such large quantities of data being created, it is essential that operators create their new files with
names that signify the content of each. Therefore, each sheet of the plan shall be contained in its own
separate design file.
Standard naming conventions shall be used for all design files, standard input files and GEOPAK criteria
files. Document all file names, both standard and project specific, in the Project Index file (For
information on the Project Index File, see ODOT’s Guidelines for Electronic Deliverables). In the
event a particular file type for the project is not addressed by this manual, use the file naming convention
as a template for selecting an appropriate name or contact the Office of CADD and Mapping Services’
CADD Services section for assistance.
In order to avoid conflicting attachments of reference files, there shall be no duplicate file names within
the project directory structure or copies of the same file within the project directory. It is not
permissible to copy the same basemap design files into multiple discipline specific sub-directories.

304.2 File Extensions
Standard file name extensions for information submitted to, or exchanged with, ODOT shall be as follows:
File Type

Extension

MicroStation design files

.dgn

MicroStation cell libraries
MicroStation/GEOPAK Resource file
GEOPAK Criteria files

.cel
.rsc
.x

GEOPAK Cross Section Input files
GEOPAK GPK Files
GEOPAK Triangle Models
Postscript Sheet Image Files
Adobe Acrobat Files
Microsoft Word Documents
Microsoft Excel Spreadsheets
Microsoft Project files

.inp
.gpk
.tin
.ps
.pdf
.doc or .docx
.xls or .xlsx
.mpp

XML files

.xml

For file types not listed above, the default file extension defined by the software shall be used.
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304.3 File Name Format
ODOT has defined the following naming convention to be used on all design files submitted to, or
exchanged with the Department.
It is not permissible to use special characters (i.e. @, #, -, >, +, %, etc.), spaces, or decimal points in
file names.
Standard Plan Insert sheets shall retain the name designated by the issuing office.
Standard Design File Naming Format
nnnnnn_aa###.dgn
nnnnnn = Five (5) or Six (6) digit PID Number
aa
= Two (2) letter code identifying the plan sheet type
(see Figure 304-1 File Name Type Codes)
###
= Three (3) digit number identifying the number of drawings of
the same type. The three digit number is required even if
there is only one drawing of a particular type in the plan set.
Examples:
123456_BE001.dgn
123456_GP005.dgn
Bridge and wall design files have unique file naming requirements, as detailed below:
For smaller projects with work on only one bridge or wall, the designer may elect to house the bridge
and wall files in the Roadway\basemaps and Roadway\sheets folders. In this case, the file names for the
bridge and wall files will use the Standards Design File Naming Format detailed above.
For projects involving bridge or wall work on more than one bridge or wall, the bridge and wall files for
each bridge or wall are stored in their own folder, as detailed in Section 302.1.1 – The Design Folder.
In this case, the bridge and wall files are named as detailed below:

Bridge Design File Naming Format
rrr_nnnns_aa###.dgn
rrr
= Three (3) digit route number
nnnn = Four (4) digit SLM of the structure, without the decimal point.
s
= One (1) digit code followed by an underscore (For twin structures: L
for Left, R for Right. C for collector/distributor roads or twin
structures combined in the same directory, P for Ramps.)

aa

= Two (2) digit Bridge plan sheet type
(see Figure 304-1 - File Name Type Codes)
###
= Three (3) digit number identifying the number of drawings of
the same type. The three digit number is required even if
there is only one drawing of a particular type in the plan set.
Examples:
071_0546L_PI002.dgn
071_0546R_SP001.dgn
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Wall Design File Naming Format
nnnnnn_yyy_aa###.dgn

nnnnnn
yyy

= Five (5) or Six (6) digit PID Number
= Three (3) digit wall number followed by an underscore
(three digits required and maximum).
aa
= Two (2) digit wall plan sheet type
(see Figure 304-1 File Name Type Codes)
###
= Three (3) digit number identifying the number of drawings
of the same type. The three digit number is required even
if there is only one drawing of a particular type in the plan
set.
Examples:
123456_001_WP005.dgn
123456_001_WS001.dgn

304.4 Supplemental Description Guidelines
ODOT allows users to provide supplemental description information by use of MicroStation’s File
Properties. The intent of the supplemental description is to provide additional descriptive information
to aid the designer in identifying a particular file.
The following properties are available in a MicroStation Design File: Title, Subject, Client, Keywords,
and Comments.
For ODOT projects, the following properties shall be used for design files submitted to or exchanged with
the Department:
Title
The Title property can be used to specify the file type description. If used, the description shall
correspond to the file descriptions for each file type shown in Figure 304-1 - File Name Type
Codes, prefixed with the Discipline name (see the examples on the following page).
Comments
The Comments property can be used to provide additional descriptive information to aid the
designer in identifying a particular file. Comments are user definable with the following
guidelines:
For Roadway design files the comment should start with the route name/number, where
applicable, using the route name as follows:
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IR###
US###
SR###
CR###

Interstate route with three digit number, e.g. IR071 for Interstate route 71.
United State route with three digit number, e.g. US033 for US route 33.
State route with three digit number, e.g. SR315 for State route 315.
County Road with three digit number, e.g. CR056 for County road 56.

RAMP###

Ramp with up to three character name/number, e.g. RAMP2S for ramp 2-S.

ROADNAME

Road name, e.g. Paris for Paris road. Note, directions (N, S, E, W) can be
used on projects where plans exist for two different directions of the same
roadway, e.g. Paris N for Paris road north.
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Following the route name/number, the Comment property can contain additional information to
help identify the specific sheet of the plan.
For Bridge design files, a brief description of the plan sheet contents should be included.
Supplemental Description Examples:
File Name

Title Property

Comments

123456_GP001.dgn
123456_MH002.dgn
123456_BP005.dgn
070_1234L_BS003.dgn

Roadway Plan & Profile or Plan
MOT Phase Details
Basemap Proposed Roadway
Basemap Bridge

IR071 Sta 50+00 to 60+00
TR123 Phase 2
SR185
Alternate C

070_1234L_SD001.dgn
070_1234L_SD002.dgn

Superstructure Details
Superstructure Details

Framing Plan
Camber/Deflection

Supplemental descriptions are optional and may be used at the designer’s discretion.

304.5 Assigning Supplemental Descriptions
Supplemental descriptions can be assigned in one of two ways:
1. Assigning properties in MicroStation. Select File > Properties to access the Properties dialog
shown below. Select the Summary tab to assign the Title and Comments properties.
2. ODOT provides a Visual Basic application, ODOT_Files.mvba, to create files using the ODOT file
naming conventions detailed in this manual. The program will automatically assign the Title
property. A key-in field is provided to enter the comments for each file created by the program.
See the ODOT CADD Services website for more information.
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304.6 Viewing Supplemental Descriptions
Supplemental description information assigned to the file properties can be viewed in Windows Explorer,
and in MicroStation file open dialog boxes.
To view the information in Windows Explorer on Windows 7 systems take the following steps:
1. From the View pull-down menu, select Details
2. Right-click on the column header to access the pop-up menu shown below. Toggle on the Title
and Comments options in the pop-up menu or if they are not available select More and toggle
on the options in the Choose Details dialog box shown below.
3. The columns can be arranged in the desired order by dragging the column headers.

70

ODOT CADD Engineering Standards Manual (ODOTcadd)

July 20, 2018
4. To save these changes, from the Windows Explorer pull-down menu select Tools > Folder
Options… Organize > Folders to open the Folder Options dialog shown below. From the View
tab, select Apply to Folders.

If the title and comments fields are not displaying in the MicroStation File Open dialog box, take the
following steps:
1. Open a MicroStation design file.
2. From the MicroStation pull-down menus, select Workspace > Preferences to access the
Preferences dialog.
3. From the Preferences dialog, select the Look and Feel category. Toggle on the Use Windows
File Open Dialogs option.
4. Close MicroStation.
5. From the MicroStation Manager dialog, change the View Menu option to Details as shown.
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Notes:
•
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The Title and Comments columns are not displayed by default. To display the columns, right
click on the column headings and toggle the options for Title and Comments on.
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Figure 304-1 File Name Type Codes
BRIDGE SHEETS

BASEMAP DESIGN FILES
Aerial Mapping

- BA

Site Plan

- SP

Bridge

- BS

General Plan

- SG

Combined Aerial and Ground

- BC

General Notes

- SN

Drainage

- BD

Estimated Quantities

- SQ

Environmental

- BV

Staged Construction Details

- SC

Existing Ground Survey

- BE

Removal

- SV

Field Book

- FB

Foundation Plan

- SO

Geometry

- BK

Rear Abutment

- SR

Geotechnical

- BI

Forward Abutment

- SF

Landscaping

- BL

Piers

- SI

Lighting

- BH

Superstructure Details

- SS

Maintenance of Traffic

- BM

Transverse Section

- ST

Profiles

- BF

Deck Plan

- SD

Proposed Roadway

- BP

Railing

- SA

Right of Way

- BR

Bearing

- SB

Signals

- BG

Expansion Device Details

- SX

Traffic Control

- BT

Miscellaneous Details

- SM

Utilities

- BU

Reinforcing Steel List

- SL

Walls

- BW

Sheeting

- SH

GEOPAK RELATED BASEMAP FILES

DRAINAGE SHEETS

GEOPAK Components in single file
(Clipping
Borders,
Pattern
Lines, - KA
Superelevation Shapes)

Drainage Schematic / Site Plan

Clipping Borders

- KC

Notes

- DN

Corridor Modeling

- KM

Sub-Summary

- DS

Digital Terrain Model Features

- KD

Plan & Profile or Plan

- DP

GEOPAK Bridge

- KB

Profile

- DF

GEOPAK Site Elements

- KI

Quantity Table

- DQ

Profile Motif File

- KF

Culvert Details

- DC

Pattern Lines

- KL

Details

- DD

Plan Motif File

- KP

Miscellaneous

- DM

Superelevation Shapes

- KS

Channel Section Sheets

- XD

GEOPAK Cross Section Cells (Channel)

- XA

GEOPAK Cross Section Cells (MOT)

- XT

GEOPAK Cross Section Cells (Roadway)

- XC
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Project Site Plan / Erosion Control /
- DE
Storm Water Pollution Prevention Plan
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LIGHTING SHEETS

RIGHT-OF-WAY SHEETS

Schematic

- LB

Legend

- RL

Notes

- LN

Centerline Survey Plat

- RC

General Summary

- LG

Property Map

- RM

Sub-Summary

- LS

Summary of Additional R/W

- RS

Plan

- LP

R/W Detail

- RD

Quantity Table

- LQ

R/W Topo

- RT

Circuit Diagrams

- LC

R/W Boundary

- RB

Elevation Views

- LE

Railroad Plat

- RR

Details

- LD

Miscellaneous

- LM

LANDSCAPING SHEETS

ROADWAY SHEETS
Title Sheet

- GT

Schematic Plan

- GB

Schematic

- PB

Typical Sections

- GY

Notes

- PN

General Notes

- GN

Sub-Summary

- PS

General Summary

- GG

Plan

- PP

Maintenance Data

- GJ

Details

- PD

Sub-Summary

- GS

Miscellaneous

- PM

Calculations / Computations

- GC

Plan & Profile or Plan

- GP

Profile

- GF

Quantity Table

- GQ

Superelevation Table

- GE

Pavement Details

- GA

Intersection / Interchange Details

- GI

Guardrail / Barrier Details

- GR

Drive Details

- GD

Miscellaneous

- GM

Fencing Plan

- GX

Layout Plan

- XL

Grading Plan

- XG

Cross Section Sheets

- XS

MAINTENANCE OF TRAFFIC SHEETS
Schematic

- MB

Notes

- MN

Detour Plan

- MD

Sub-Summary

- MS

Typical Sections

- MY

Miscellaneous

- MM

Phase Details

- MH

Phase Plan & Profile or Plan

- MP

Profile

- MF

Quantity Table

- MQ

MOT Cross Section Sheets

- XM

74

ODOT CADD Engineering Standards Manual

July 20, 2018

SIGNAL SHEETS
Notes

- CN

TRAFFIC CONTROL SHEETS
(Pavement Marking and Signing)

General Summary

- CG

Schematic

- TB

Sub-Summary

- CS

General Notes

- TN

Plan

- CP

General Summary

- TG

Quantity Table

- CQ

Sub-Summary

- TS

Details

- CD

Calculations / Computations

- TC

Miscellaneous

- CM

Plan

- TP

Quantity Table

- TQ

GEOTECHNICAL EXPLORATION SHEETS

Elevation Views

- TE

Boring Logs (8.5x11)

Details

- TD

Miscellaneous

- TM

- IL

SOIL PROFILE SHEETS
Cover

- IC

UTILITY SHEETS (Water, Sanitary, etc)

Lab Data

- ID

Schematic

- UB

Plan & Profile or Plan

- IP

Notes

- UN

Profile

- IF

General Summary

- UG

Cross Sections

- IX

Sub-Summary

- US

Calculation / Computations

- UC

Plan & Profile or Plan

- UP

Profile

- UF

Quantity Table

- UQ

Elevation Views

- UE

Details

- UD

Miscellaneous

- UM

STRUCTURE FOUNDATION EXPLORATION SHEETS
Cover

- ZC

Plan & Profile or Plan

- ZP

Profile

- ZF

Boring Logs

- ZL

Lab Data

- ZD

WALL SHEETS

GEOHAZARD EXPLORATION SHEETS
Cover

- YC

Plan & Profile or Plan

- YP

Profile

- YF

Cross Sections

- YX

Boring Logs

- YL

Lab Data

- YD
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Schematic

- WB

Calculation / Computations

- WC

Details

- WD

Elevation

- WE

Estimated Quantities

- WQ

Foundation

- WT

Plan & Profile or Plan

- WP

Profile

- WF

Miscellaneous

- WM

Notes

- WN

Sheeting

- WH

Typical Section

- WY

Sub-Summary

- WS

Steel List

- WL

Cross Section Sheets

- WX
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304.7 ODOT_Files.mvba
ODOT provides a custom program, ODOT_Files.mvba that can be used to create MicroStation Design Files
for the project. This program is available on the ODOT CADD Services Website.

305 GEOPAK Digital Terrain Models
305.1 General
The naming of GEOPAK Digital Terrain Models (DTM) is defined as shown in the table below:
Digital Terrain Models (DTM) - .tin
Aerial Mapping Existing
- nnnnnn_XAE##
Bridge Deck/Surface Existing - nnnnnn_XBR##
Bridge
Deck/Surface nnnnnn_PBR##
Proposed
Combined Aerial and Ground - nnnnnn_XCB##
Survey Existing
Ground Survey Existing
- nnnnnn_XGR##
Proposed
- nnnnnn_P##
where:
nnnnnn = Five (5) or Six (6) digit PID number
## = 2 digit number 01, 02, 03, . . .

306 GEOPAK Coordinate Geometry Databases
306.1 General
When coordinate geometry calculations are processed in GEOPAK by use of the legacy GEOPAK Coordinate
Geometry tools, the resulting geometric elements are stored in a separate binary file. This Coordinate
Geometry (COGO) database, the GPK file, is then used by other GEOPAK processes for a variety of tasks.
In addition to storing the GEOPAK Coordinate Geometry information, the GPK file is used to store field
survey information when the survey data is processed using the legacy GEOPAK Survey tools.
Each project, regardless of its size, shall have one COGO database (.gpk file) containing all project data
processed through GEOPAK Survey or GEOPAK COGO commands. For projects involving multiple
locations, it is permissible to use separate GPK files for each.
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The naming of the GEOPAK Coordinate Geometry Database files submitted to ODOT shall be as follows:
GPK Files - .gpk
GEOPAK Coordinate Geometry Database - Job###.gpk
where:
job = GEOPAK Naming Convention
### = 3 digit route number or first three
characters of street name
306.1.1 Using OpenRoads Tools
The SELECTseries 3 release of GEOPAK includes new OpenRoads Civil Geometry tools that can be
used to define horizontal and vertical alignments graphically. The geometric information generated
by the use of these tools is stored in a MicroStation basemap design file for ODOT projects. Section
304-1, File Naming Convention, details the use of various basemap files for discipline specific tasks.
Figure 304-1 – File Type Codes details the file naming convention for the basemap files. The
OpenRoads Civil Geometry information is stored in the following file for a typical ODOT project:
File Type (Per Fig. 304-1)

Directory

Geometry Basemap – BK

Per Figure 302-1.3; (\Design\Geopak\Basemaps sub-directory)

The GPK file is not automatically created when using the new OpenRoads technology; however users
will have the ability to create one if necessary. Civil geometry elements must be exported to a
GEOPAK COGO database (GPK file) in order to be used by the legacy GEOPAK plan production tools,
such as Plan and Profile Clipping, Plan View Labeling, etc. The same GPK file shall be used for
exporting OpenRoads Civil Geometry information that is used for all other GPK file related tasks.
Field survey data processed using the new OpenRoads Survey tools is stored in a MicroStation design
file and is not stored in a GEOPAK GPK file, as with the legacy GEOPAK Survey tools. OpenRoads
Survey information is stored in the following design file for a typical ODOT project:
File Type (Per Fig. 304-1)

Directory

Survey Fieldbook – FB

Per Figure 302-1.6; (\Design\Survey\RawData sub-directory)

The Fieldbook design file is not used by design personnel and is intended to be a record of the data
collection, processing, and editing as completed by the Surveyor. Once the data processing is
complete, a Survey Basemap is exported from the Fieldbook design file for use by the design
personnel. The Survey Basemap design file is exported to the following folder:
File Type (Per Fig. 304-1)

Directory

Survey Basemap – BE

Per Figure 302-1.6; (\Design\Survey\Basemaps sub-directory)

The OpenRoads survey data can be exported to the GPK file if needed; however, it is not mandatory.
If the survey data is required in a GPK file, it shall be exported to the same GPK file used for the
project. The use of multiple GPK files for ODOT projects is not permitted.
The GEOPAK GPK file is stored in the \Design\Geopak sub-directory for a typical ODOT project.
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306.2 GEOPAK COGO Element Names for OpenRoads
To facilitate the efficient sharing and transfer of COGO information between consultants, ODOT, and
contractors, the GEOPAK COGO Element Names detailed below have been established.
Each OpenRoads Civil Geometry horizontal and vertical alignment is uniquely named within the
MicroStation design file. These alignment names do not have the same limitations as GEOPAK COGO;
however, since the alignment information must be exported to the GPK file for use with many of the
workflow processes within GEOPAK, it is important to ensure that OpenRoads horizontal and vertical
alignment names are compatible with the GPK element name formats.
This section details COGO element names for projects using the OpenRoads Civil Geometry tools to
generate horizontal and vertical alignments that will be subsequently exported to the GEOPAK GPK File.
For COGO Element names that are not user definable when using the OpenRoads Civil Geometry
horizontal and vertical alignments, such as spirals, and curves, or not currently supported items such as
parcels, see the ODOT CADD Engineering Standards Manual, section 300 FILE MANAGEMENT.
COGO element names in the GEOPAK GPK file are limited to a maximum of 15 alphanumeric characters.
No special characters, periods, or spaces are permitted other than the underscore character.
For ODOT projects, horizontal alignment chain names shall be limited to 12 characters as detailed below.
Vertical alignment names are limited to a maximum of 15 characters and use a two or three character
prefix followed the Horizontal Alignment name.
When OpenRoads Civil alignment information is exported to the GPK file, sub-element names for
horizontal alignments (points, curves, and spirals) are automatically defined by the software. Therefore,
sub-element names are not specifically defined for ODOT projects when the horizontal alignment data is
defined using the OpenRoads Civil Geometry tools. Note that Point names can be defined using the Next
Available Settings function within GEOPAK COGO.
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The following element names for horizontal and vertical alignments have been established for OpenRoads
Civil Geometry elements.
Civil Geometry Alignment Elements

Roadway / Misc. Alignments

Horizontal Alignments (Chains)

Horizontal / Vertical Alignments

Alternates Existing

AX#_rddd%%

Cable Line Existing

CABt_###o

Alternates Proposed

AP#_rddd%%

Construction Limit

CON_rddd##o

Baseline Existing

BLX_rddd%%

Construction Limit Alternates

CONA_rddd##o

Baseline Proposed

BLP_rddd%%

Culvert

CULt_rddd_sssss

Centerline Existing

CLX_rddd

Ditch

DITt_###o

Centerline Proposed

CLP_rddd

Driveway

DRt_rddd_ssssso

Centerline MOT Existing

CLX_MOT_rddd

Electric Line

ELEt_###o

Centerline MOT Proposed

CLP_MOT_rddd

Gas Line

GASt_###o

Centerline Right of Way Existing

CLX_RW_rddd

Right of Way

RW_rddd##o

Centerline Right of Way Proposed

CLP_RW_rddd

River / Stream

RIVt_###

Centerline of Survey

CLX_SV_rddd

Sanitary
Storm Sewer

SANt_###o
STMt_###o

Telecommunication

TELt_###o

Water Line

WATt_###o

Where:
r=Route Type
C=County Road

Where:

I=Interstate Route
R=Ramp

t=Type, X (Existing) or P (Proposed)

S=State Route

o=Side, if applicable, L (Left) or R (Right)
sssss =Station or Drive Name

T=Township Road

10+23.45 would be 01023

U=U.S. Route
ddd=3 digit route number 020, 270, 142, etc.

100+25.67 would be 10026

%%=1-2 digit Ramp number A, 2S, 3A, etc.

##=2 digit number maximum 01, 02, . . .
###=3 digit number maximum 01, 100, etc.

#=1 digit number 1, 2, . . .
Notes: If the route type is unknown or the road is
a local street, the rddd code should be
replaced with the street name ensuring
that the resulting horizontal alignment
name is no longer than 12 characters.
For projects where multiple alternates are
considered, once the alignment and profile
have been selected they should be copied
and given the name of the proposed
elements. This will ensure that the
proposed alignments are named uniquely
rather than just being one of the many
alternatives.
Vertical Alignments
Existing Profile

X_name

Proposed Profile

P_name

Proposed Profile Alternates

A#_name

Where:

r=Route Type
C=County Road
I=Interstate Route
R=Ramp
S=State Route
T=Township Road
U=U.S. Route
ddd=3 digit route number 020, 270, 142, etc.
Notes: If the route type is unknown or the road is a
local street, the rddd code should be
replaced with the street name, or a portion
of the street name. This will ensure that the
resulting horizontal or vertical alignment
name is no longer than 15 characters.
If a profile is needed for the above
elements, name the profile the same as the
corresponding chain.

name=The name of the horizontal alignment the
profile is associated with
#=1 digit number 1, 2, 3, etc.
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COGO Right of Way Elements

COGO Right of Way Parcels

Chains

RWrddd###

Curves

RWC###

where:
###=3 digit number maximum 01, 100, etc.
r=Route Type
C =County Road
I =Interstate Route
S =State Route
T =Township Road
U =U.S. Route
ddd=3 digit route number 020, 270, 142, etc.
Notes: If the route type is unknown or the road is
a local street, the rddd code should be
replaced with the first four characters of
the street name.

Parent Tract
##
Types of Title
##_ppppnz
where:
##=2 or more digit number 01, 02, 03, . . .
Note: The number for the Types of Title shall
match the number of the Parent Tract.
pppp=1 to 4 character parcel identification code
as shown below.
Fee Simple Title (store a Taking in GEOPAK)
Acquired Fee Simple Excess Land
EL
Excess Land Sold or Swapped
ES
Fee Simple Excess Land
E
Fee Simple Uneconomic Remnant ER
Limitation of Access
WL
Reservation of Access
WD
Easements (store as Easement in GEOPAK)
Aerial
A
Channel
CH
Flowage
FL
Limited Access
LA
Railroad or Public Utility
U
Scenic Easement
SC
Standard Highway
SH
Sewer
SW
Slope
SL
Temporary Easement
T
Agreements (store as Easement in GEOPAK)
Work
WA
Others (store as Occupied in GEOPAK)
Present Road Occupied (PRO)
PRO
PRO Inside
PROI
PRO Total
PROT
n=When the parent tract has multiple Types of
Title of the same type, a 1 digit number is
used to identify each Type of Title.
z=Additional Modifiers:
In the name of another State
agency, LPA, etc.
V
Special Reservation
R
Examples:
03 (parent tract)
03_LA (easement for parent tract 03)
03_WD1 (taking for parent tract 03)
03_PRO (occupied area for parent tract 03)
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307 GEOPAK Project Manager
307.1 General
The GEOPAK Project Manager is used to facilitate the organization of GEOPAK related data during project
development. The GEOPAK Project Manager file has a .prj file extension. For ODOT projects, use of the
Project Manager with GEOPAK Road is optional, but is recommended with GEOPAK Survey.
The GEOPAK Road and GEOPAK Survey software applications both make use of the .prj file. For ODOT
projects, it is recommended that you do not use the same .prj file for both the GEOPAK Road and GEOPAK
survey software applications.
If the Survey data is to be processed with the OpenRoads Survey tools, use of the GEOPAK Project Manager
is not required.
307.1.1 GEOPAK Road Users
For GEOPAK Road users, the GEOPAK Project Manager files (.prj) should be stored in the
\Design\Geopak sub-directory. GEOPAK will create additional files and sub-directories in the
\Design\Geopak sub-directory as required by the software. The .prj file shall be named as follows
for use with GEOPAK Road:
nnnnnn_Design.prj
where nnnnnn = Five (5) or Six (6) digit PID Number
307.1.2 GEOPAK Survey Users
For GEOPAK Survey users, the GEOPAK Project Manager file (.prj) should be stored in the
\Design\Survey sub-directory. GEOPAK Survey will create additional files and subdirectories as
required by the software. The .prj file shall be named as follows for use with GEOPAK Survey:
nnnnnn_Survey.prj
where nnnnnn = Five (5) or Six (6) digit PID Number

307.2 Setting up a Project for GEOPAK Road
When creating a new project for GEOPAK Road, use the following guidelines to supplement the project
information.
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Items under the Create New Project dialog.
(1)

Project Name: For this example, this field would be nnnnnn_Design.

(2)

Working Directory: Used to specify the default directory that GEOPAK will use to open and save
files. For this example this field would be set to \project\FRA\123456\Design\Geopak\

(3)

Job Number: This is used to identify the Coordinate Geometry (COGO) Database (gpk) for the
project.
Use the three digit number for the mainline route number. For example, for State Route 4 the
Job Number would be 004, for Township Road 50 it would be 050, etc.
In cases where there is not an established route number, the first three characters of the road
name should be used.

(4)

The Project Description field shall contain the following information.
County-Route-Section:
PID Number:
State Job Number:
Project Manager:
Project Designer:
Project Description:

FRA-070-0.00
123456
555555*
Ms. Jane Doe
Mr. John Dow
The scope of work for project 12345
goes here. Include as much detail as
necessary to define the work done
for the project.

* If the State Job Number (SJN) is not assigned at the time of creation, leave the area blank where the
number is required. Update this field when SJN number is assigned.
In the middle of the Create New Project dialog, select the Preferences button to access the GEOPAK
User Preferences dialog. The values shown below are the recommended settings for an ODOT project.
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307.3 Setting up a Project for GEOPAK Survey
Before you create a new Survey project, you must first set the default Survey Preferences using the
Default Preferences dialog. The values assigned for the Default Preferences are used when the Survey
project is created.

Items under the Default Preferences dialog related to creating the .prj file for use with GEOPAK Survey:
1) Name: This field is used as the name for the .prj file. For this example, the name would be
nnnnnn_Survey, where nnnnnn = the PID number for the project.
2) Directory: This field is used to define the directory where the .prj file is created. The directory
would be set to the \survey folder for the project.
3) Job Directory: This field is used to define the directory where the .gpk file for the project will
be stored. The .gpk file shall be shared between the GEOPAK Road users and the GEOPAK Survey
users. The Job Directory should be set to the \Design\Geopak folder for the project.
4) Global Working Directory: This field is used to define the folder used as the parent folder for
all other GEOPAK Survey software functions. The Global Working Directory should be set to the
\Design\survey folder for the project.
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400 PLOTTING
401 General
401.1 General
ODOT is now using multi-page PDF files for plan submissions instead of TIFF images. PDF printing is
facilitated using the MicroStation Print Organizer.
The Print Organizer is a MicroStation utility for printing and reprinting a set of design files, models, or
Project Explorer links. The files that are to be printed are saved as a print set, (PSET), file.
ODOT includes a template PSET file, ODOTcaddseed.pset, prepopulated with folders to organize the
design files that will make up the print. The PSET folder structure mimics the plan set structure from
Section 1300 of the Location and Design Manual, Volume 3. Additional directories can be added if
needed. When the PDF is generated, the empty directories will not be included. The PSET folder names
become the multi-page PDF bookmarks.
In the ODOT_Styles_Printing.dgnlib, Print Styles are defined that control the output from Print Organizer.
Print Styles include ODOT standard Plot Configuration Files and Pen Tables, and enable generation of
PDF files as well as printed output. The ODOT_Styles_Printing.dgnlib also defines a named expression,
ODOT_SheetName, which can be applied to the plot set. This reads the Sheet Name from the model
property of a sheet model type and applies it to the name of the page in the PSET. The template PSET
file uses this named expression as the default. If the Sheet Name in Model Properties is blank, then the
Model Name from the Model Properties dialog is used as the default page name.
ODOT uses pen tables that are applied to the graphical elements when the design file is plotted. The pen
tables translate various elements in the design file to the final output version.
Elements should be plotted black, with the exceptions listed in Section 401.2.6 – Color Plotting. The
major and minor grid levels are set to a lower priority, so they plot under most plan sheet details. Cross
section and profile grids should be plotted as shown in the Location and Design Manual, Volume 3,
Figure 1202-1.
Standard MicroStation plotting files are included in ODOT’s CADD Standards download, available on the
Office of CADD and Mapping Services, CADD Services web page. The files available for download
include user documentation. Also, see PDF Printing with Print Organizer in the Project Management
with the ODOTcadd Standards Training Guide for additional details.
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401.2 Plotting
MicroStation pen tables and Printer Driver Configuration files for use with MicroStation V8i are located
in the following directory for ODOT users:
•

..\ODOTcadd\Standards\pltcfg\

Plotting documentation is located here:
•

..\ODOTcadd\Standards\ODOT\Documentation\Plotting\

The plotting documentation has detailed settings and usage information. The following briefly describes
the settings in the Printer Driver Configuration Files, (ODOTcadd.pltcfg, ODOTcaddL.pltcfg and
ODOTcadd_PDF.pltcfg), and pen tables, (ODOTcadd_Pen.tbl and ODOTcadd_PenC.tbl). An additional
Printer Driver Configuration File, (ODOTcadd_PDF_Levels.pltcfg), is distributed with the standards but is
not currently in use for plan submissions.
Note: Elements not handled by the Shading or Masking sections of the ODOTcadd_Pen.tbl are plotted
Black.
401.2.1 Line Weights
The Printer Driver Configuration Files specify the MicroStation element weight to output line
thickness. Line weights in the configuration files are defined as below for 22”x34” Prints. The
configuration files set the Weight Scale to 0.5 for 11”x17” and 8 ½”x11” prints, so the thickness is
one-half the values shown in the table. The Style Scale is also set to 0.5 for 11”x17” and 8 ½”x11”
prints, reducing the dash and gap lengths of standard MicroStation line styles by one half. Though
line thicknesses are defined to weight 10, only weights 0-5 are used in ODOT’s level standards:

WT= 0

Thickness
(approximate inches)
0.006”

WT=1
WT=2
WT=3
WT=4
WT=5
WT=6
WT=7

0.014”
0.026”
0.036”
0.046”
0.056”
0.066”
0.076”

WT=8
WT=9
WT>=10

0.086”
0.096”
0.106”

Element Weight

Due to the variation in plotting accuracy of various printers, the thicknesses shown in the table above
can be modified as deemed necessary to achieve the desired results.
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401.2.2 Priority and Transparency
Plotting priorities are determined by the MicroStation level and the assigned element Priority values
in the ODOT_Levels_General.dgnlib. Priority and Transparency are not handled in the ODOT standard
pen tables.
401.2.3 Shading
The following functionality to shade various plan sheet elements is included in the
ODOTcadd_Pen.tbl:
•

Cross Section Grids
The pen table shades Major and Minor Cross Section Grids using the following settings:
Major Grid – uses Color = 42 (RGB Value = 176, 176, 176)
Minor Grid – uses Color = 43 (RGB Value = 192, 192, 192)

•

Shading Filled Shapes – is an option to highlight specific areas on the plan sheet.
Shading levels were created to fill shapes with varying shades of Gray. The pen table fills
shapes based on the following shading levels:
SC_Shading1 – uses Color = 41 (RGB Value = 160, 160, 160)
SC_Shading2 – uses Color = 43 (RGB Value = 192, 192, 192)
SC_Shading3 – uses Color = 45 (RGB Value = 224, 224, 224)

•

Shading Reference(s) – is a method to fade the entire Reference into the background.
To gray shade a reference, the Logical Name must begin with gray, for example gray1, gray2,
etc. Color 41 (RGB Value = 160, 160, 160) is used to gray shade references. When plotting
a reference using a logical name beginning with gray, the pen table will gray shade the entire
reference.

•

Title Sheet Shading
Corporation boundaries and route shield fills on the Title Sheet Area Map are handled in the
pen table.

401.2.4 Masking
Masking is an option to hide specific areas on a plan sheet. No elements will show underneath.
The Masking level plots all elements, or filled shapes, as White to mask any elements underneath.
The pen table processes elements on the following masking level:
SH_Masking – uses Color = 255 (Background Color)
Note: To create a border around the masking shape change the color and place the shape using the
Fill Type set to Outlined.
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401.2.5 Text Substitution
Text replacement of the text string, (`````), on sheet borders is handled by the pen table. The
default setting inserts the file name, model name, date, time and username using Printing Accounting
Variables.
401.2.6 Color Plotting
The ODOTcadd_PenC.tbl is used for producing color output of an ODOT plan sheet. This pen table
does the Major and Minor Cross Section shading and Reference shading the same as above. Some text
on the SH_Data level is changed from White to Black by the pen table, so that it will display. Text
substitution is handled as above. All other elements are plotted in their display colors.
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